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Introduction 

  

 

Quick Start Guide 

Congratulations, you’re on your way to becoming an efficient reader!  AceReader Elite is an award-winning software 
program that can help you unlock your full reading potential. The program contains three essential tools in one package: 
(1) a Reading Assessment Tool to determine and track your current reading speed and level; (2) a Reading 
Improvement Training Tool to help increase your reading speed and comprehension (both online and offline); and (3) 
an Online Reading Tool to help you read more efficiently while online. 

 

When you start AceReader Elite, you will be presented with a startup screen that explains the main four parts of the 
program. You can then click on one of the four buttons to launch you into that part of the program. The “Home Screen” 
has four tabs: 

(1) Course Mode – This tab provides students with the easiest way to use the program for training purposes. The 
Course will lead them through each step of the training process. To learn more about the Course Mode Tab, refer 
to the Course Mode Overview section. 

(2) Menu Mode – This tab provides students with the ability to have more control over their reading activities. They can 
simply select the activity they want to perform from the list of activities presented. To learn more about the Menu 
Mode Tab, refer to the Menu Mode Overview section. 

(3) Reading Mode – This tab provides students with an explanation of the Reading Mode screen. It also allows them 
to enter the Reading Mode. The Reading Mode screen provides them with full control over their reading material, 
display modes and reading speeds. To learn more about the Reading Mode Tab, refer to the Reading Mode 
Overview section. 

(4) Admin – This tab allows teachers to perform Administration functions such as adding Users, monitoring students’ 
progress by viewing Test Results, creating custom content (for the Tests, Drills and/or Games) and the ability to Set 
other system wide option Settings. To learn more about the Admin Tab, refer to the Administration Overview 
section. 
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About AceReader Elite 

 

Quick Introduction: 

AceReader is referred to as: Reading Improvement Software; Reading Assessment Software; Productivity 
Reading Tool; Self-Improvement Educational Reading Tool; Reading Fluency Software; Vision Training 
Software; Speed Reading Software. 

Teachers often say... "Finally I found a modern day software version of a Tachistoscope machine used years ago 
to pace eye movement." 

It can be used to: (1) assess your current reading level; (2) improve your reading speed and comprehension, both 
online and offline; and (3) help you read faster while on the computer, by utilizing special display modes. 

In today's fast-paced information age, it is more important than ever to be a proficient reader. Everyone from high-
powered executives to children just learning to read in grade school can benefit from AceReader. 

Our goal is to help you read faster, while maintaining or even improving your comprehension. When you accomplish 
this, reading becomes like watching a movie. It becomes fun to read because you're able to absorb more material in 
a shorter amount of time. In short, it leads to more success and a better overall quality of life. 

Like anything, it takes practice. AceReader is not designed to teach you how to read, but instead focuses on helping 
you be more proficient at your reading both on and off the computer. 

 
Problems AceReader Elite Solves: 

AceReader helps you become a more proficient reader by helping you: 

(1) Reduce Subvocalization (pronouncing or whispering the words in your mind while you read)   

You typically can only subvocalize about as fast as you can talk. The program pushes you to read at 
higher speeds through pacing techniques. At these higher speeds, it is physically impossible to 
subvocalize. 

(2) Eliminate Regression (allowing your eyes to wander back to re-read text) 

The program will display or highlight words in a manner that will help encourage forward-only eye 
movement. In non-highlight modes, words are presented without the surrounding text being shown at all. 
This promotes forward-only eye movement since there is no previous text visible. 

(3) Reduce Your Eye Fixation Time 

Reducing the time spent when your eyes are focused on a single point.  

(4) Expand Your Eye Fixation Zone  

Improving your ability to read a wider text width when your eyes are focused on a single point. 

(5) Increase Your Re-Fixation Speed  

Improving your ability to reposition your eyes at a rapid rate. 

 
Technologies Used: 

AceReader utilizes two technologies: (1) RAPID SERIAL VISUAL PRESENTATION (RSVP) and (2) 
TACHISTOSCOPIC SCROLL PRESENTATION (TSP). When AceReader is in RSVP mode, text is displayed in the 
center of the text area. RSVP can help you to read faster than normal because your eyes do not need to move. In 
RSVP mode, the words come to your eyes instead of your eyes going to the words. When AceReader is in TSP 
mode, text is displayed in a manner that forces your eyes to move just like they do in normal reading. TSP can train 
you to read in a normal fashion and at higher speeds. Both modes can help you learn to take in multiple words at a 
time. 

AceReader Elite can handle text in European languages as well as English since it supports the international ASCII 
character Set.  

AceReader Elite also utilizes additional, patented technologies that have been incorporated into the main screen 
options and controls. 

 

Primary Ways to Use AceReader Elite:  

 Reading Assessment Tool - To determine and track your current reading speed and comprehension. 

 Reading Improvement Tool - To help increase your reading speed and comprehension (both online and offline). 
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 Online Reading Tool - To help you read more efficiently while working or surfing online. 

 

Innovative Ways to Use AceReader Elite: 

 Dyslexia Aid - Adjust your reading by selecting slower speeds or by bursting sentences one word at a time. 

 ESL Aid - Use AceReader Elite to help learn English as a Second Language by improving your English reading 
skills. 

 Eye Tracker - Train your eyes to move left-to-right and top-to-bottom by using the "Eye Trainer Mode."  This 
mode forces your eyes to move as they would in normal offline reading. 

 Foreign Language Instructor - Use AceReader Elite as a computerized flash card system to read and re-read 
text for the purpose of learning a foreign language. AceReader Elite supports the international ASCII character Set 
(i.e. English, Spanish, German, French, Italian, etc.). 

 Memorization and Flash Card Tool - Use AceReader Elite’s Flash Card Game to memorize learning material 
(i.e. state capitals, multiplication tables …). You can also use the Burst Forward, Back, and Repeat features to 
rapidly read and re-read text for the purpose of memorizing it.  

 PhotoReading Aid - Use AceReader Elite to flash whole pages of text at desired speeds to assist with online 
PhotoReading techniques. 

 Self-Improvement Programmer - Step up the speed and rapidly display messages to yourself to program your 
subconscious with positive suggestions. 

 Speed Reading Aid - Use AceReader Elite to assist your eye tracking at configured speeds. This will help you 
break common bad reading habits that slow you down (i.e. subvocalization and regression). 

 Tachistoscope – Use AceReader Elite as a pacing tool. Some teachers have noted that AceReader Elite is a 
modern-day software version of the mechanical tachistoscope machines from years ago  Those machines, which 
would flash text onto a screen at configurable speeds, were used to help many students and teachers learn how 
to read better by pacing their eye movement. AceReader Elite goes beyond their capabilities, though, by providing 
many additional options and features and it includes the ability to track student progress. 

 Vision Aid - Change the text font and background color to help see more clearly and to read without eye 
movement. 

 Warm Up - Use AceReader Elite to warm up your reading skills before switching over to read online or offline. 
Warming up can help increase your reading speed. 

 

Benefits of Using AceReader Elite: 

 Better grades in school. Children learn the skills that will pay benefits throughout high school and college and into 
the workplace.  

 Better performance on the job, where reading skills are increasingly important.  

 More free hours in your life as your reading speed increases.  

 Better quality of life as your reading, comprehension and retention grow year after year. 
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What Makes AceReader Elite, Elite? 

 

We designed AceReader Elite by listening closely to what our customers had to say about our original AceReader 
program. Here is a list of the AceReader Elite’s current highlights and improvements: 
 

 Startup Screen – Explains the main four parts of the program and launches you into that part of the program. 
This makes understanding the basic layout of AceReader Elite intuitive and easy to use. 

 Goals – We allow you to Set goals and monitor your progress relative to your current Base Reading Speed. 
Your goal speed is also used when performing the “Reach your Goal Speed” Drills to determine pacing speeds. 

 Themed Tests  – We used to sell themed/leveled Reading  Comprehension Tests as optional add-ons. We 
now included that material in the base product. We also added them to the Courses. 

 E-books  – We included some e-books that you can load from the File menu within the “Reading Mode” section 
of the program. There are millions of e-books available on the Internet that you can download and load into the 
“Reading Mode” section of the program, but we decided to include a list of some of our favorite ones for your 
use. 

 Unlimited Users  – We used to limit the number of Users that could simultaneously use the program, 
depending on the version of software you had. We now permit an unlimited number of Users in our base 
product. 

 Modern  – The User Interface now has a whole new look and feel. It’s modern, clean and incorporates many 
features requested by our customers. We also support the laTest OS versions. 

 Courses – Walk you through the training process. 

 Advanced Display Modes - Allows you the ability to highlight with white space formatting, to specify amount of 
text to display or highlight in terms of "number of eye fixations per line," and to specify amount of text to flash at 
a time in terms of "number of sentences" or "number of phrases" (whole thoughts at a time). 

 Advanced Burst Options - Provides you with more ways to specify the amount of text that will be displayed or 
highlighted before stopping. 

 Advanced Speed Controls - Allows you to Set up the front screen speed control so it will have whatever low, 
high and target speed you want. The speeds are specified in terms of WPM (Words per Minute), CPS 
(Characters per Second) or CPM (Characters per Minute). The character-based speeds are useful if you want 
long words to display for longer periods of time than shorter words. You also have the ability to fine-tune your 
speed with a variety fine tune options (i.e. fixed speed, delays …). 

 Bookmark Capability - Allows you to Set and go to Bookmarks. You can even perform a special function that 
will load a file and position you to a Bookmark. This is useful for resuming your reading at the point you left off 
during the previous session. 

 Comprehension Test Editor - Provides the ability to create and edit your own Reading Comprehension Tests.  

  Comprehension Tests (now 830 in total) - Includes 20 Reading Comprehension Tests in the General Test 
Set at each grade level 1-12, plus an additional 20 at an adult reading level for a total 13 X 20 = 260 Reading  
Comprehension Tests. In addition you receive 130 Comprehension Tests EACH (grades 1-2 and adult) for the 
four Specialty Test Sets and 50 Comprehension Tests for the SAT-ACT Test Set. 

 Custom Preset Options - Allows you to Set the options the way you want and then to save and restore them. 
This gives you the power to get the program Set up quickly according to the type of reading you want to do. 
These Preset custom options can also be used to define the Drills using the Drill Editor. 

 Customizable Hotkeys - Allow you to map the functions you use most often used with the keyboard keys of 
your choice. 

 Drill Editor – Leads you through the process of performing reading exercises. These Drills can be Set up with 
explicit reading speeds or can utilize the reader’s Base Reading Speed. By utilizing the Base Reading Speed, 
the Drills automatically become more challenging as you improve. 

 Drills, Drills and more Drills - Lead you through the process of performing reading exercises. These Drills use 
reading material that is separate from the reading material used with the  Comprehension Tests and they are 
ordered from easiest to hardest. They have also been grade-leveled.  

 Games (challenging and fun!) - Help you read more material in less time by reducing your eye fixation time 
and by expanding your eye fixation zone. One of the Games is a Flash Card Game, which has the dual purpose 
of helping your reading speed and comprehension and memorizing learning material (i.e. state capitals, 
multiplication tables …). 

 Game Editors - Allows you to incorporate your own Game Text. Especially handy for the Flash Card Game. 



Introduction 

5 

 Home Screen – Explains the main four parts of the program and launches you into that part of the program. 
This makes understanding the basic layout of AceReader Elite intuitive and easy to use. 

 Import and Export Content Ability - Allows the AceReader Elite community to share Reading Comprehension 
Tests and Drills created using the built-in Editors.  

 Manual Timer - Allows you to pace yourself and the program to automatically calculate your speed. 

 Network Version (Network Version Only) - Designed for reading lab environments. With the Network Version, 
students do not need to sit in front of the same computer for each session, and teachers can monitor the 
progress of the students from any computer on the network. Central Administration functions allow teachers to 
view graphical and statistical Comprehension Test Results for all students. Teacher Administration functions 
include: User Management, Custom Options Management, Drill Text Management, Drill Management and 
Comprehension Test Management. 

 Read Timer – Keeps track of your actual reading/training time. 

 Readability Statistics Analysis Tool - Included for both the Comprehension Test Editor and the Drill Text 
Editor. The Readability Statistics Analysis Tool will help you determine the proper grade level of the reading 
material. 

 Spell Checker - Included for both the Comprehension Test Editor and the Drill Text Editor. 

 User Interface - Provides a way to hide/show the controls by displaying mouse-over help. The front screen now 
shows a running average for your reading speed in terms of WPM (Words per Minute), and it contains an 
Estimated Time of Completion indicator to help you determine how long it will take to complete your reading. 

 Warm-Up Drills - Take advantage of white space formatting and force your eye movement in pre-specified 
patterns. These help you increase your overall reading speed. 
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Offline Reading Tips 

One of the most important and the most helpful, reading aids is known as previewing. Previewing gives you a sense 
of the material -- such as topic, level of difficulty, author’s style and length -- before you actually sit down to read it. It 
allows you to decide whether or not you want, or need, to spend the time reading the entire passage to obtain more of 
the details. In short, it allows you to become a more efficient and effective reader. 

 

Use the following steps to preview: 

 

1. Establish a purpose for reading this material. Have a specific reason for reading the material, whether the 
motivation comes from within or without. You’ll vary your approach and techniques to achieve that outcome. 

 

2. Study the title, headings and subheadings. The give you a quick cue as to what the topic of discussion will be. 
They may also be a deciding factor in determining your purpose and establishing your course of action. 

 

3. Look at the first and last paragraphs. These can provide you with a quick introduction and conclusion of the 
material contained in the main part of the text. 

 

4. Look for bold-faced, italicized and underlined words. These are words or ideas that the author thought were 
important enough to highlight for you. A quick overview of these words will give you a sense of where the author is 
heading with the material. 

 

5. Look at the visual aids. Graphs, charts, diagrams, maps and illustrations all provide support for what’s in the main 
part of the text. They create a vivid mental picture of the people, things and ideas under discussion. They can also 
provide a quick grasp of the relationships between the data or other concepts in the main part of the text. 

 

You should preview everything you read, regardless of its complexity or length. Here are some suggestions for a 
couple different types of material: 

 

General non-fiction/textbooks -  

1. Look at the organization. There are usually chapters, sections, a table of contents and an index. Look for chapter 
headings and key subheadings. 

2. Look at the chapters. Individual chapters may have their own index/overview and summary/content questions. 

3. Look at the beginning and end of sections. The most important information is usually contained there, with details in 
the middle part. 

4. Look at the Setup of diagrams, pictures, graphs, etc. 

5. Read the book’s preface/introduction for an overview of the author’s purpose and content. 

6. Within the chapters, preview the introductions, summaries, charts, etc. Decide if you need to read for more details. 

 

Letters and Memos -  

1. Consider the Setup. The opening and closing paragraphs are usually cordialities and contain little vital information. 

2. Head to the important parts. The earlier and later middle paragraphs contain the most important information. 

3. Look at who sent it, the date sent, if there’s a "re:" line and who else received it. 

4. Skim or read the middle paragraphs to get details and decide appropriate response. 

 

News -  

1. Consider the organization. News is usually organized in an inverted pyramid -- the most important information is 
first, then the details, in order of importance. 

2. Read the first and last paragraphs for an overview and the conclusion. 

3. Look at the graphs, diagrams, etc. and decide if it’s worth taking the time to read the rest of the article. 
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Using AceReader Elite 

 

Logging On and Adding Users 

 

The first screen that appears when you start AceReader Elite is the logon screen. By logging on, you allow the 
program to separate the program Settings and Comprehension Test Results from other Users/students. 

 

How to Add Users:  

 

There are two ways to add Users: 

 

(1) Adding Users from the logon screen: 

From the Logon screen, simply type your name in the User Name field, and then click Start. You will then 
be prompted twice for a password. You will need that password to log on from this point on.  

Note: You can keep the password blank if you want. If you keep the password blank, you will not need to 
enter a password when logging on.  

Note: The ability to add Users from the logon screen can be disabled by the Administrator (“Admin” 
User). Refer to the section titled Miscellaneous Options for more information on this feature. 

 

(2) Adding Users via User Administration: 

You can logon as the “Admin” User and add Users via the “Add Users...” User Management function. 
Refer to the section titled User Management for more information on how to perform User Administration. 

 

How to Log On:  

When you start the program, you will see a logon screen. Enter your name in the "User Name" field and press the 
"Start" button. You can either type your name in the User name field or select it from the list of existing names 
(depending on the Admin Misc. option Settings). If selecting from a list, you can see the list of existing names by 
clicking on the small button (with the downward pointing triangle) found on the right side of the name field. If your 
name does not exist in the list of Users then refer above on how to add a User.  

It recommended that Users select their User name from the list of logon names after the first time they log on. This 
will help ensure that they are logging on as the same person every time. To configure the logon screen to show a 
list of names, you will want to uncheck the “Force Users to type their logon name when logging on” option in the 
Admin Misc. options. 

The "Admin" User is a special User (typically the teacher or a single User of the program) who is responsible for 
the Administration functions of the program. When logged in as the "Admin" User, you have access to the "Admin" 
menu items. From the Admin menu, you can perform: (1) User Management, (2) Custom Options Management, (3) 
Drill Text Management, (4) Drill Management, (5) Comprehension Test Management, (6) Game Text Management 
and (7) Miscellaneous Options. Refer to: Administration Overview. 

It is important for students to log off when they are done with their session. Logging off will prevent the same 
User from being logged on more than once at any point in time. Logging off will also allow other students to log on 
from the same computer.  

Note: If a User cannot log on because the User forgot his or her password, then refer to User Management section 
for instructions on how to remove the current password. After removal of the password, the User will be prompted 
for a new password the first time he or she tries to log back on. 
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Ergonomic Suggestions 

 

While training, patience and a positive attitude are essential!   

 

Use the following hints to maximize your progress: 

1. Keep your shoulders level and relaxed, and align them with your ears and hips. 

2. Keep your elbows close to your sides (when typing/using mouse) and your knees lower than your hips. 

3.  Keep your head tilted slightly downward. With your feet on the floor or on a footrest, hold your head upright 
and look straight at the monitor. The top of your screen should be at or below eye level. 

4.  Make sure your screen is clean, with no window glare. 

5.  Try to create a good learning environment. That means eliminating as many distractions as possible -- i.e. 
turn off phone, turn off e-mail notification, turn off music, remove paperwork from field of vision. 

6.  Take a few deep breaths and make sure you’re positioned and ready to concentrate before you start each 
Drill. 

7.  Remember to blink. When people read from a computer, they tend to blink less than from a printed page. 
That can lead to discomfort such as eye burning, tearing or drying out. 

8.  Take a break at least once every hour by standing and stretching for about 30 seconds. 

9.  Make the commitment to practice every day. The more you do, the faster and more easily you’ll become a 
Speed Reader! 
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Course Mode 

 

Course Mode Overview 

The Course Mode will step you through the training process.  

 

Courses consist of the following types of activities: 

 Setting your Base Reading Speed (BRS) – Your Base Reading Speed is used by the program to auto-Set the 
speed Settings during the Drills. 

 Periodic Self-Paced Tests - This will reset your Base Reading Speed if minimum requirements are met (as 
defined by the Base Reading Speed option Settings). It will also provide another data point (reading speed and 
comprehension) so that you can monitor your progress over time. 

 Warm-Up Drills – These are Warm-Up eye exercises. These exercises pace eye movement in a fashion that is 
not exactly like reading, but will serve to Warm-Up the User and prepare him or her for the normal Drills. 

 Drills – This is like the Warm-Up exercises, but it is not considered a “Warm-Up” since it paces you during 
normal reading exercises. The eye pattern will consist of the same motion that you perform during normal 
reading activities (both on and off the computer). 

 Eye Exercise Games – These Games are eye exercises that allow you to have fun while being challenged. 
These activities allow you to: reducing your eye fixation time, expanding your eye fixation zone and increase 
your re-fixation rate. These are all activities that will help you become a better and more proficient reader. 

 

In addition to performing the above activities, students can always monitor their progress by pressing the “View Test 
Results” button, where they can view their Test scores and reading speeds. The Test Results are shown in a list and 
can also be viewed graphically. 

   

You can change the course and/or set your Goal Speed by clicking on the “Change Course & Set Goal” button.  Your 
Goal Speed is always displayed at the bottom of this screen next to your Base Reading Speed.  Setting your Goal 
Speed allows you to monitor your progress relative to your Goal Speed.  Note: Your Goal Speed must be set if you 
select a Course that uses your Goal Speed to calculate pacing speeds. 

 

Note: It is possible to customize the Courses. If you are interested in doing that, feel free to send StepWare, Inc. an e-
mail (support@stepware.com) with your request. We can then Setup a phone conference to walk you through the 
process. 
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Menu Mode 

 

Menu Mode Overview 

The Menu Mode allows you to have more control over your training process than the Course Mode. You can simply 
select the reading assessment and reading improvement activities from the menu. 

 

Overview: We recommend that you take a Self-Paced Reading Comprehension Test once a day (i.e. at the beginning 
of your training session). Your Base Reading Speed (BRS) is reset to the speed you read the story if certain criteria 
are met (i.e. comprehension level was 75% or better, Test was not repeated...). Your BRS teaches the program how 
fast to pace you during some of the Drills. Your reading speed and comprehension are also logged, which allows you 
to monitor your progress over time. After you take a Self-Paced Reading Comprehension Test, you will want to spend 
the rest of your time with the Drills and Games. That’s it! 

 

You will need to press the “Set Goal” button to set your Goal Speed.  Your Goal Speed is always displayed at the 
bottom of this screen next to your Base Reading Speed.  Setting your Goal Speed allows you to monitor your progress 
relative to your Goal Speed.  Note: Your Goal Speed must be set if you perform Drills that use your Goal Speed to 
calculate pacing speeds. 

 

Tip: Plan to spend about 15 minutes per training session with the program. Training every day is best, but you can still 
achieve positive results training less (i.e. every other day). 

 

Tip: The Tests and Drills are ordered from simplest to hardest. It is reasonable for you, regardless of your age, to 
simply start at the beginning of each list and work your way down.  

 

Tip: When performing the Drills, do not focus on comprehension. Instead, you want to follow the words with your eyes. 
The Drills are mainly eye exercises. Their speed will sometimes be very fast, but, again, don't worry about 
comprehension; rather, just try to follow the words with your eyes. Note: Comprehension will come over time without 
concentrating on it.  

 

Tip: When selecting Drills, we recommend that you perform one “Warm-Up” Drill, then one or two of the other Drills 
(i.e. “Push to Double Speed”). Warm-Up Drills can be done in any order. The other Drill Sets (i.e. “Push to Double 
Speed”) should be performed in the order shown. You only need to perform a few Drills each day. After you have 
performed the Drills, spend the rest of your time with the Games. 

 

Tip: You can refer to the Help (within the software) for reference and more documentation. 

 

Remember… Success comes from Positive Attitude, Patience and Practice. You can do it! 

 

 

Refer to the following sections for more information: 
 

Assessment Activities: 

 Take Comprehension Test (Self-Paced)  

 Take Comprehension Test (Forced Speed/Mode)  

 View Comprehension Test Results  

 

Reading Improvement Activities: 

 Perform Warm-Up Drills  

 Perform Drills  

 Play Eye-Span Game  

 Play Eye-Span Comprehension Game  

 Play Tachistoscope Flash & Recall Game  

 Play Search/Scan Game  
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 Play Flash Card Game  

 

 

 

 

 

Reading Assessment Activities 

 

Take Comprehension Test (Self-Paced) 
 

To take a Self-Paced Comprehension Test, select Take Comprehension Test (Self-Paced) from the Menu Mode tab 
screen.  

Select a Comprehension Test Set and a specific Comprehension Test within the Set. Press the Begin 
Comprehension Test button to start. The program will lead you through the rest of the process.  

Perform this type of Test to Set your Base Reading Speed. Some of the Drills will utilize your Base Reading Speed to 
Set the speed. You should perform Self-Paced Comprehension Tests periodically (i.e. once a day at the beginning of 
your training session) so your Base Reading Speed is kept up to date and so you can monitor your progress over time. 

With this type of Test, the text will appear in "normal fashion" (without flashing). The reading will be followed by a Set of 
Comprehension Test questions. The reading portion of the Test is Self-Paced, but you will be timed. The program will 
log your speed and comprehension scores for use in the Drills.  

Your reading speed is always logged. However, since it is possible to flip back and forth between the story and the 
quiz, the total time you spend reading the story will accumulate, and it is this total figure that will be used to calculate 
your reading speed.  

Canceled Tests are also logged. When viewing Test Results, you will be able to tell if the Test was canceled by looking 
at the Comprehension Test Score. The Comprehension Test Score for Tests that were canceled will be marked with "--
-". Knowing if a Test was canceled is useful to keep track of how much time you spent familiarizing yourself with the 
story before you completed the actual Test. The graphs only plot data for completed Tests. 

AceReader Elite comes with its own set of Comprehension Tests that are broken out by grade levels 1-12 plus an adult 
level. Test Sets that come with the program are marked with a "#" as the first character of their name. These Tests are 
ordered from easiest to hardest. Each time you take a Test, the program will remember/highlight the last Test you took. 
We recommend that you pick a starting level (typically the first level), and, each time you take a Test, simply work your 
way down the list.  

Note: For the Tests that come with the program, the levels were determined by running the Test stories through 
common readability formulas. Reading speed is not factored into the leveling. It is best to think of the leveling as 
"complexity levels" as opposed to "grade levels."  It is not necessary to stick with Tests that map to your age and/or 
grade level. Keep in mind, for example, that newspapers are read by adults, but they are typically written at about the 
6th to 8th grade level. You may therefore want to use the levels to help determine the highest level appropriate for your 
Test taking. In other words, an adult might want to use all the levels, but a 5th grader may only want to use levels 1-8. 

Note: You can create, import and export additional sets of Comprehension Tests (refer to: Comprehension Test 
Management). 
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Take Comprehension Test (Forced Speed/Mode) 
 

To take a Forced Speed/Mode Comprehension Test, select Take Comprehension Test (Forced Speed/Mode) from the 
Menu Mode tab screen.   

Select a Comprehension Test, an Option Setting and a Target Speed. Press the Begin Comprehension Test button 
to start. The program will lead you through the rest of the process.  

Perform this type of Test to determine how well you comprehend the reading material when forced to read in different 
modes and at different speeds. The text will appear as defined by the Options and Speed you specify. The program 
will log your speed and comprehension scores. 

Canceled Tests are also logged. When viewing Test Results, you will be able to tell if the Test was canceled by looking 
at the Comprehension Test Score. The Comprehension Test Score for Tests that were canceled will be marked with "--
-". Knowing if a Test was canceled is useful to keep track of how much time you spent familiarizing yourself with the 
story before you completed the actual Test. The graphs only plot data for completed Tests. 

AceReader Elite comes with its own set of Comprehension Tests that are broken out by grade levels 1-12 plus an adult 
level. Test Sets that come with the program are marked with a "#" as the first character of their name. These Tests are 
ordered from easiest to hardest. Each time you take a Test, the program will remember/highlight the last Test you took. 
We recommend that you pick a starting level (typically the first level) and, each time you take a Test, simply work your 
way down the list.  

Note: For the Tests that come with the program, the levels were determined by running the Test stories through 
common readability formulas. Reading speed is not factored into the leveling. It is best to think of the leveling as 
"complexity levels" as opposed to "grade levels."  It is not necessary to stick with Tests that map to your age and/or 
grade level. Keep in mind, for example, that newspapers are read by adults, but they are typically written at about the 
6th to 8th grade level. You may therefore want to use the levels to help determine the highest level appropriate for your 
Test taking. In other words, an adult might want to use all the levels, but a 5th grader may only want to use levels 1-8. 

Note: You can create, import, export… additional Sets of Comprehension Tests (refer to: Comprehension Test 
Management). 

 



Using AceReader Elite 

13 

View Comprehension Test Results 
 

To view your personal Comprehension Test Results, press the View Test Results button from the Menu Mode tab 
screen.  

Your Base Reading Speed and Test Results are shown. You can view your Test Results in two forms: (1) a list sorted 
by date and time and (2) graphs of your speed and comprehension. The graphs are lined up so you can see how your 
speed and comprehension correlate. 

It is important to view your Comprehension Test Results periodically so you can track your progress. Your Test Results 
are stored in a database and you can view them at any time. 

Note: You can specify filters by clicking the Filter Options button. Filter Options allow you to filter out certain Test 
Results. Examples of Test Results that you may want to filter out: (1) Test Results for Tests that have been repeated, 
(2) Test Results for Tests that have been previously canceled, (3) Test Results for Self-Paced Tests that indicate 
extremely low or extremely high reading speeds (i.e. User was distracted or walked away from the program or quickly 
clicked the Done button while the story was being presented during a Self-Paced Reading Comprehension Test). The 
default setting is recommended and will help you monitor valid Test Results over time.  

Note: The Teacher/Administrator can view the Test Results for all students. Test Results can also be exported to a file 
for further processing and/or printing. See section: User Management for more information. 

 

Example Test Results Graph: 
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Reading Improvement Activities 

 

Perform Warm-Up Drills 
 

To perform a Warm-Up Drill, select Perform Warm-Up Drills from the Menu Mode tab screen.  

Select a Warm-Up Drill then press the Begin Drill button to begin.  

Note: You may be required to take a Self-Paced Test if the Drill you are taking utilizes your current Base Reading 
Speed. 

 

The following discussion provides background rationale behind the Warm-Up Drill Set: 

As the name implies, these Drills are designed to help you "Warm-Up". The Warm-Up Drills display text with fixed 
fonts and with white space formatting. They will pace your eye movement at increasing speeds and will utilize 
various text patterns. 

We recommend that you perform any one of these Warm-Up Drills each training session. Note: Each Warm-Up 
Drill consists of four sessions. 
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Minimize Subvocalization Drills 
 

To perform these Drills, select Minimize Subvocalization from the Menu Mode tab screen.  

These Drills will help you minimize subvocalization (pronouncing words in your mind while you read). You don't 
necessarily need to eliminate subvocalization, but you want to minimize it.  

Focus your eyes on the center of the text and work on reading the displayed text without vocalizing the words in your 
mind. Don't focus on your inner voice. Relax, as it may take some time to get used to the process. 

NOTE: It is fine to subvocalize at times (i.e. when reading headlines or at the beginning of articles), but you want to work 
on minimizing the practice. 

NOTE: Each Drill consists of four sessions at pre-programmed speeds that you can override. 

 

Eliminate Re-Reading & Regression Drills 
 

To perform these Drills, select Eliminate Re-Reading & Regression from the Menu Mode tab screen.  

These Drills will help you eliminate Re-Reading/Regression (letting your eyes wander back to re-read text). With these 
Drills, the program will flash text without the surrounding text to help keep your eyes moving forward. Over time, you will 
break the habit of letting your eye wonder back to re-read text. 

Comprehension is obviously very important, but when performing these Drills, you will want to worry less about 
comprehension and more about eye movement. Just do the best you can at following the words with your eyes. 
Comprehension will come with time. 

NOTE: Each Drill consists of four sessions at pre-programmed speeds that you can override. 

 

Expand Eye Fixation Zone Drills 
 

To perform these Drills, select Expand Eye Fixation Zone from the Menu Mode tab screen.  

These Drills will help you expand your eye fixation zone (ability to read a wider text width when your eyes are focused on 
a single point). 

With these Drills, focus on the center of the text and use your peripheral vision to see all the words. This activity will flash 
text in the center of the screen and will allow you to concentrate on this one skill without moving your eyes. 

NOTE: Each Drill consists of four sessions at pre-programmed speeds that you can override. 

    

 

Reduce Eye Fixation Time Drills 
 

To perform these Drills, select Reduce Eye Fixation Time from the Menu Mode tab screen.  

These Drills will help you reduce your eye fixation time (time spent when your eyes are focused on a single point). 

With these Drills you want to focus on reducing the amount of time you spend each time your eyes stop when reading 
partial lines. This activity will flash text in the center of the screen and will allow you to concentrate on this one skill 
without moving your eyes. 

NOTE: Each Drill consists of four sessions at pre-programmed speeds that you can override. 

 
 

Increase Re-Fixation Speed Drills 
 

To perform these Drills, select Increase Re-Fixation Speed from the Menu Mode tab screen.  

These Drills will help you increase your Re-Fixation Speed (ability to reposition your eyes at a rapid rate). 

With these Drills you want to focus on rapid eye movement. This is primarily an eye exercise. You should be 
concentrating on quickly moving your eyes from one eye fixation point to the next. 
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NOTE: Each Drill consists of four sessions at pre-programmed speeds that you can override. 

 

Perform More Eye Pacing Drills... 
 

To perform an Eye-Pacing Drill, select Perform More Eye Pacing Drills from the Menu Mode tab screen.  

We include many more training Drills. 

NOTE: As with all the Tests and Games, it is possible to create custom Drills using our advanced Administration 
functions. Custom Drills are accessed from this selection. 

 

 



Using AceReader Elite 

17 

More Discussion About Drills 
 

AceReader Elite Drills are designed to help you improve your reading skills. They are based on sound reading 
principles and many years of educational research. In fact, many teachers refer to AceReader Elite as an "improved 
version" of the mechanical tachistoscope machines from years ago. Drills simply flash text at pre-defined speeds and 
in specified modes. You can think of Drills as "eye exercises" that flash or highlight text to pace your eye movement 
and help you break common bad reading habits. 

 

AceReader helps you break two major bad habits: 

 Subvocalization (pronouncing the words in your mind while you read). 

 Re-Reading/Regression (letting your eyes wander back to re-read text). 

 

AceReader will also help you: 

 Reduce Your Eye Fixation Time (time spent when your eyes are focused on a single point). 

 Expand Your Eye Fixation Zone (ability to read a wider text width when your eyes are focused on a single 
point). 

 Increase Your Re-Fixation Speed (ability to reposition your eyes at a rapid rate). 

 

Drills will pace you at speeds relative to your Base Reading Speed and/or your Goal Speed. 

 

The following discussion provides background rationale behind the Double Speed Drills:  

 

These Drills begin by flashing text at your Base Reading Speed. They gradually increase to double the Base 
Reading Speed then step back down to 1.2 times that speed. The same text is used throughout each Drill. The 
idea is to push you to higher rates, then back down to something slightly faster than the Base Reading Speed. At 
that point the 1.2 times reading rate will seem slow compared to the double speed, even though it is faster than the 
Base Reading Speed. This allows you to step-stone your way to faster and faster speeds.  

Note: You should perform Self-Paced Comprehension Tests periodically so your Base Reading Speed is kept up 
to date and so you can monitor your progress over time. As your Base Reading Speed increases, the Drills will 
automatically adjust to push you to faster speeds. 

 

The following discussion provides background rationale behind the Triple Speed Drills:  

 

This set of Drills is a more aggressive version of the "Push to Double Speed" Set.  

These Drills begin by flashing text at your Base Reading Speed. They gradually increase to triple the Base 
Reading Speed then step back down to 1.5 times that speed. The same text is used throughout each Drill. The 
idea is to push you to higher rates, then back down to something slightly faster than the Base Reading Speed. At 
that point the 1.5 times reading rate will seem slow compared to the triple speed, even though it is faster than the 
Base Reading Speed. This allows you to step-stone your way to faster and faster speeds.  

Note: You should perform Self-Paced Comprehension Tests periodically so your Base Reading Speed is kept up 
to date and so you can monitor your progress over time. As your Base Reading Speed increases, the Drills will 
automatically adjust to push you to faster speeds. 

 

The following discussion provides background rationale behind the Goal Speed Drills: 

 

This set of Drills is a more aggressive version of the "Push to Double Speed" Set.  

These Drills begin by flashing text at your Base Reading Speed. They gradually increase to your Goal Speed, then 
step back down to 1.2 times that speed. The same text is used throughout each Drill. The idea is to push you to 
higher rates, then back down to something slightly faster than the Base Reading Speed. At that point the 1.2 times 
reading rate will seem slow compared to the triple speed, even though it is faster than the Base Reading Speed. 
This allows you to step-stone your way to faster and faster speeds.  

Note: You should perform Self-Paced Comprehension Tests periodically so your Base Reading Speed is kept up 
to date and so you can monitor your progress over time. As your Base Reading Speed and Goal Speed increases, 
the Drills will automatically adjust to push you to faster speeds. 
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The following discussion provides background rationale behind the Eye-Robic Progression Drill Set: 

 

The Eye-Robic Progression Drills are ordered from easiest to hardest. We recommend that you perform the Drills 
in the same order as they are presented in the list. 

There are three separate readings for each of the 13 levels in AceReader Elite: Beginner, Intermediate and 
Advanced. The Drills move you progressively through your reading. Each Drill Set contains several sessions and 
consists of: (1) Eye-Robics, an eye-exercise to help smooth out the reading process and (2) a number of Drills. 

As you progress through the Drills, the text will be Set to different sizes, styles, colors and speed of presentation. 
The first Drill of each reading is set at a speed slower than your Comprehension Test Speed. This gives you an 
opportunity to become accustomed to the presentation. As you progress through the Drills, the presentation rate 
also increases. The final Drill of most of the readings consists of the full text. This allows you to read through the 
document without interruption and at a higher speed. 

 

 



Using AceReader Elite 

19 

Play Eye-Span Game 
 

To play the Eye-Span Game, select Play Eye Training & Brain Games from the Menu Mode tab screen.  

Press the Space Bar key to start and stop the Game. Press the Left Arrow key to indicate that the flashed words are 
NOT the same. Press the Right Arrow key to indicate that the flashed words ARE the same. 

The object of the Game is to earn 10 smiley faces. You earn smiley faces when the number of your correct answers 
exceeds the number of your incorrect answers. You can change the Options Settings to make the Game more or less 
challenging.  

The Eye-Span Game will help you: (1) Reduce Your Eye Fixation Time (the time spent when your eyes are focused on 
a single point), (2) Expand Your Eye Fixation Zone (the ability to read a wider text width when your eyes are focused 
on a single point) and (3) Increase Your Re-Fixation Speed (the ability to reposition your eyes at a rapid rate). These 
are skills that are required to become a proficient reader. 

Note: You can also create your own text to be used by the Game (refer to: Game Text Management).  

 

 

Play Eye-Span Comprehension Game 
 

To play the Eye-Span Comprehension Game, select Play Eye Training & Brain Games from the Menu Mode tab 
screen.  

Press the Space Bar key to start and stop the Game. Press the Left Arrow key to indicate that all the flashed words 
are NOT related in meaning. Press the Right Arrow key to indicate that all the flashed words ARE related in meaning. 

The object of the Game is to earn 10 smiley faces. You earn smiley faces when the number of your correct answers 
exceeds the number of your incorrect answers. You can change the Options Settings to make the Game more or less 
challenging.  

The Eye-Span Comprehension Game is similar to the Eye-Span Game except it has a "Comprehension" element to it. It 
will help you increase your eye span and eye fixation speed while you are also being forced to think about the meaning 
of the words flashed on the screen. 

Note: You can also create your own text to be used by the Game (refer to: Game Text Management).      

 

 

Play Tachistoscope Flash & Recall Game 
 

To play Tachistoscope Flash & Recall Game, select Play Eye Training & Brain Games from the Menu Mode tab 
screen.  

Press the Space Bar key to flash text. After the text has flashed on the screen, you need to answer the question that 
appears on the screen to validate that you were able to read and recall the text. This Game helps demonstrate how 
fast you are able to read when presented with a short burst of text. It also increases your eye span and eye fixation 
speed. 

The object of the Game is to earn 10 smiley faces. You earn smiley faces when the number of your correct answers 
exceeds the number of your incorrect answers. You can change the Options Settings to make the Game more or less 
challenging.    

Note: You can also create your own text to be used by the Game (refer to: Game Text Management). 
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Play Search/Scan Game 
 

To play the Search/Scan Game, select Play Eye Training & Brain Games from the Menu Mode tab screen.  

With the Search/Scan Game, you will search for a pre-specified word or symbol within a list or body of text. Take note 
of the text for which you are searching then press the Space Bar to start. Click on the text for which you are searching 
before the specified time runs out. You can press the arrow keys (or X for page down, Z for page up) to navigate 
forward and backward one page at a time. 

The object of the Game is to earn 10 smiley faces. You earn smiley faces when the number of your correct answers 
exceeds the number of your incorrect answers. You can change the Options Settings to make the Game more or less 
challenging.   

Searching/Scanning is something we do many times in our daily lives (i.e. looking up phone numbers, recipe 
ingredients, research...), and the Game can help you become more skilled at this common daily activity. 

Note: You can also create your own text to be used by the Game (refer to: Game Text Management). 

 

 

Play Flash Card Game 
 

To play the Flash Card Game, select Play Eye Training & Brain Games from the Menu Mode tab screen.  

Press the Space Bar key to flash text. After the text has flashed on the screen, you will be presented with a question 
that you need to answer. 

The object of the Game is to earn 10 smiley faces. You earn smiley faces when the number of your correct answers 
exceeds the number of your incorrect answers. You can change the Options Settings to make the Game more or less 
challenging.   

The Flash Card Game is similar to the Tachistoscope Flash & Recall Game except it has a "Comprehension" element 
to it. This Game is considered a "Bonus" Game because in addition to using it for reading improvement purposes, it 
can also be used as a memorization tool. It comes with Times Tables, State Capitals and Vocabulary exercises.  

Note: You can also create your own text to be used by the Game (refer to: Game Text Management). 
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Reading Mode 

 

Reading Mode Overview 

 

The Reading Mode allows full access to all the program features and options. Enter this mode if you want to: 

(1) Train in manual while having full control of the reading material (i.e. maybe reading material you needed to read 
anyway), display mode and speed. 

or 

(2) Use AceReader Elite as a tool to help you read more efficiently while on the computer (i.e. Web page, e-mail, 
word processing documents, pdf files, e-books…). 

 

Refer to the following sections for more information: 

Training in Manual Mode  

Using AceReader Elite as an Online Reading Tool  
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Training in Manual Mode 

 

In addition to performing formal Drills and playing the Games, you can use AceReader Elite in a less structured way to 
train and to improve your reading skills. The Reading Mode (otherwise known as Manual Mode) provides you with full 
control over how you train. 

 

To use the product in Manual Mode: 

 

1.  Place text into AceReader Elite by loading files or using the clipboard with Web content or other training 
material; these features are found under the File menu. By using the clipboard, you can select your own, varied 
reading material, such as Web pages, e-mail, word-processing documents, etc.  

 

2.  Set the options (found under the Options menu or Preset-Options menu). 

 

3.  Set the speed by clicking on the speed bars (lower left of the main screen). 

 

4.  Press the Play/Stop buttons to start and stop the text flashing. 

 

You can Set the options to display text left-to-right and top-to-bottom to force your eye movement, just as you do with 
normal reading. You can also change many options, such as speed, number of words to display per screen update, font, 
font size, font color, background color, margins, speed and delays. Refer to the section titled: General Usage Overview 
and for details on how to Setup and perform these functions. 

 

We recommend training in this mode by pushing yourself way beyond your "comfortable" reading speed, then slowing 
back down to a speed slightly faster than that comfortable speed. Over time, your comfortable reading speed will 
increase. This allows you to step-stone your way to faster and faster speeds. 

 

Recommended Training Technique: First take a Self-Paced Reading Comprehension Test to determine your Base 
Reading Speed. Then try practicing at 1X, 2X and even 3X your Base Reading Speed. At 3X, the speed will seem very 
fast, but that’s okay; just try to keep your eyes on the text. At high rates of speed, you will want to worry less about 
comprehension and more on just following the text with your eyes. Then back down to something a little faster than your 
original Base Reading Speed. You’ll typically find that it will seem very readable, even though it is faster than your 
original speed. Then try it again, increasing your pace to higher and higher speeds in this fashion. 

 

Example of Recommended Training Technique: For the sake of an example, let’s say your Base Reading Speed 
(determined by taking a Self-Paced Reading Comprehension Test) is 100 words/minute. You would want to practice 
reading at 100 words/minute, then 200 words/minute and then 300 words/minute. Then you would back down to 120 
words/minute. In this example, the 120 words/minute will seem very readable, even though it is faster than your original 
Base Reading Speed. Once you feel comfortable at 120 words/minute, you can repeat the process with higher and 
higher speeds. 

 

 

Below is a list of features that will be useful when using AceReader Elite as a Self-Improvement Educational 
Tool: 

 

Bursting (Front Screen Features):  

You can use the Burst feature to read a Set number of words or sentences at your current speed before stopping 
and you can customize the amount of text that is displayed. Refer to the "Set Burst Options" sub-section within the 
"Options Menu" section for more detail on configuring this feature. One way to use the Burst feature is to set the 
speed high, as well as to Set some fine tune speed options (i.e. Long Word Delays). You can quickly burst through 
chunks of text, then, depending on your comprehension, you can press the "Forward" and/or "Repeat" Burst buttons 
to continue your reading. 

 

Clipboard:  

You can use the clipboard as a tool to load text from other applications (i.e. your favorite word processor, Web 
browser, e-mail client, etc.). 
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Custom Options: 

You can save your current option Settings under a name of your choice. Then, whenever you want to return 
AceReader Elite to those Settings, you can simply select that custom option. You may find this useful if you like to 
use different option Settings for different types of reading material or if you want to train in several different modes. 

 

Educational Mode Default Option Settings: 

You can select a Preset educational mode from the "Educational Highlight Mode Default Option Settings" and 
"Educational Non-Highlight Mode Default Option Settings" submenu found under the "Preset-Options" menu. 
Selecting any of the menu items found under the "Preset-Options" menu will set all the program options.  After you 
choose an educational mode, you can make further adjustments by going to the "Options" menu. 

 

Estimated Completion Time (Front Screen Feature):  

You can estimate how long it will take you to complete the current document by giving this front screen indicator 
your current position and speed setting. This can help you manage your reading time. 

 

Eye Trainer Mode: 

You can use the Eye Trainer Mode to force your eyes to move left-to-right and top-to-bottom, just as you would do in 
normal reading. In this mode, you are forced to keep reading ahead because surrounding text is not visible. This 
mode helps you break the bad habit of "regression" (letting your eyes wander back to re-read text). Practicing to 
read in this mode will help you become a better reader both online and offline. 

 

Load Comprehension Test Story: 

You can load comprehension story material without taking the actual Comprehension Tests. 

 

Load Drill Text: 

You can load Drill reading material without performing the actual Drills.  

 

Other Options Settings:  

You can choose from many other options to make your online reading experience more efficient and enjoyable: (1) 
font color; (2) font size; (3) background color; (4) display mode; (5) fine tune speed options (i.e. delays) and much 
more. You will find all these options under the "Options" menu.  

 

Read Timer (Front Screen Feature): 

You can ensure you practice reading for certain periods of time by using the Read Timer feature. It keeps track of 
actual read time. It can be reset at any time by pressing the small reset button next to the read time display. 
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Using AceReader Elite as an Online Reading Tool 

 

AceReader Elite is the ideal Online Reading Tool. Many people use AceReader Elite to read faster and more efficiently 
while online. Others find AceReader Elite's unique way of presenting text an easier and more enjoyable way to read. Still 
others find it useful as a Productivity Tool. 

 

You can load text from plain-text files and also from the clipboard. By using the clipboard, you can read Web pages, e-
mail, word-processing documents, etc. And you can change many options (number of words to display per screen 
update, fonts, font size, font color, background color, margins, speed, delays, etc.) to enhance your online reading. 

 

You can Set the options to display text one word (or a few words) at a time in the center of the screen at high rates of 
speed. In this mode, the words are coming to your eyes instead of your eyes going to the words. Many people find 
reading in this mode much more efficient. 

 

Refer to the General Usage Overview section for details on how to use AceReader Elite in this mode. Basically, you will 
be (1) loading text into AceReader Elite; (2) Setting the options the way you want; and then (3) pressing the Play/Stop 
buttons to start and stop the text presentation. 

 

 

Below is a list of features that will be useful when using AceReader Elite as a Productivity Tool: 

 

Bookmarks:  

You can use Bookmarks as an easy way to return to saved locations in your reading material. The AceReader Elite 
Bookmark feature operates in much the same way as Bookmarks do in the real world.  

 
Bursting (Front Screen Features):  

You can use the Burst feature to read a Set number of words or sentences at your current speed before stopping 
and you can customize the amount of text that is displayed. Refer to the "Set Burst Options" sub-section within the 
"Options Menu" section for more details on configuring this feature. One way to use the Burst feature, is to Set the 
speed high and also to Set some fine tune speed options (i.e. Long Word Delays). You can quickly burst through 
chunks of text, then, depending on your comprehension, you can press the "Forward" and/or "Repeat" Burst 
buttons to continue your reading. 

 

Center Text Mode Option:  

You can read better and faster while online by using the "Center Text Display Mode."  You can select this mode by 
selecting the "Set Display Mode" option found under the "Options" menu. In "Center Text Mode" the words come to 
your eyes instead of your eyes going to the words. Text is presented in the center of the screen and you can focus 
on it with minimal eye movement. 

 
Clipboard:  

You can use the clipboard as a tool to load text from other applications (i.e. your favorite word processor, Web 
browser, e-mail client, etc.).  

 

Custom Options: 

You can save your current option Settings under a name of your choice. Then, whenever you want to return 
AceReader Elite to those Settings, you can simply select that custom option. You may find this useful if you like to 
use different option Settings for different reading materials. 

 

Estimated Completion Time (Front Screen Feature):  

You can estimate how long it will take you to complete the current document by giving this front screen indicator 
your current position and speed setting. This can help you manage your reading time. 
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Other Options Settings:  

You can choose from many other options to make your online reading experience more efficient and enjoyable: (1) 
font color; (2) font size; (3) background color; (4) display mode; (5) fine tune speed options (i.e. delays) and much 
more. You will find all these options under the "Options" menu. 

 

Pre-Set Productivity Modes:  

You can select a Preset productivity mode from the "Productivity Mode Default Option Settings" submenu found 
under the "Preset-Options" menu. Selecting any of the menu items found under the "Preset-Options" menu will Set 
all the program options. After you choose a productivity mode, you can make further adjustments by going to the 
"Options" menu.  

 

Programmable Hotkeys Option:  

You can assign keyboard keys of your choice to common functions (i.e. start/stop toggle, loading AceReader Elite 
with the clipboard, etc.). This makes performing common functions easier and quicker since you do not need to use 
the mouse or factory-Set hotkeys. 

 

Sentence Search (Front Screen Feature): 

You can move your current reading position to the beginning of the next sentence that contains the word (or 
phrase) you are searching for. This is a non-case-sensitive search. You can perform the search on the text within 
the currently-loaded document, either while stopped or while the text is being flashed. To perform this type of 
search, first type in the word (or phrase) you want to find in the input field next to the "Sentence Search" button 
then press the "Sentence Search" button. 

 

Upper Left Mode Option:  

This mode is similar to the "Center Text Mode" (refer above), except the text will always be presented with a fixed 
starting position (upper left margin tab position). 
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General Usage 

 

General Usage Overview 
 

For detailed explanations of how to perform certain tasks, refer to the following sections: 

 

How to Start and Stop Flashing Text  

Using Hotkeys  

 

Positioning Methods 

Positioning Methods Overview  

Using Bookmarks  



How to Load/Save Reading Material 

How to Load/Save Reading Material Overview  

Using the Clipboard  



Customizing AceReader Elite 

Selecting Preset Options  

 

Manually Setting Options 

Setting Up the Text Display Area  

Setting Text Flash Rate  

Mapping Your Own Hotkeys  

Setting Burst Options  

Setting up Read Timer  
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How to Start and Stop Flashing Text 
 

There are several ways to start and stop flashing text. 

 

Stop/Play buttons:  

When you click the Play button , the text will start flashing. Text will continue to flash until either you click the 

Stop button  or you reach the end of the document. 

Note: The Start and Stop buttons are mapped to hotkeys. Refer to Mapping Your Own Hotkeys. 

 

 

Burst-N-Stop buttons:  

   

When you click the Burst buttons, text will start flashing. Text will continue to flash until you click the Stop button 

, until the "burst amount" of text has been displayed or until you’ve reached the end of the document.  

The "burst amount" is defined in terms of "number of sentences," "number of words," "phrases," or "screen 
updates."  Refer to Setting Burst Options for more information.  

You can use the Burst feature to read a Set the amount of text at your current speed before stopping and you can 
customize the amount of text that is displayed.  This is useful both for practicing and for quickly skimming through 
text. Set the speed high. Then, when the text stops flashing, you can reflect on what you just read before manually 
deciding if you want to proceed or re-read previous text. 

Repeat: The Burst Repeat button allows you to go back in the document to re-read the "burst amount" of text you 
just completed (repositioned 1 x "burst amount" of text). At that point, the text will start flashing until the "burst 
amount" has been displayed. 

Forward: The Burst Forward button allows you to start reading at your current position. It flashes a "burst amount" 
of text before stopping. 

Note: The Burst buttons are mapped to hotkeys. Refer to Mapping Your Own Hotkeys for more information.  

 

Manual Mode: 

  

Click on the Manual Back (left arrow) or Manual Forward (right arrow) to manually scroll back or forward one word 
Set. The green and red buttons above the Manual Forward button allow you to turn on and off the manual timer. 
The manual mode buttons allow you to self-pace yourself, and the timer will keep track of your speed (in 
words/minute). 
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Using Hotkeys 
 

Hotkeys enable you to access commonly used functions using a series of keystrokes rather than using the mouse. .  

You can configure the key-to-function mapping to suit your preference. Refer to: Mapping Your Own Hotkeys for more 
information. 

 

The following table is a list of the functions with their default hotkey equivalent: 

 

Function Default Hotkey 

Load Clipboard Control V 

Hide/Show Top Controls Toggle F11 

Hide/Show Bottom Controls Toggle F12 

Faster Speed (one speed bar unit) Shift Up Arrow 

Slower Speed (one speed bar unit) Shift Down Arrow 

Faster Speed (one speed unit) Up Arrow 

Slower Speed (one speed unit) Down Arrow 

Stop/Play Toggle Space 

Page Back Page Up 

Page Forward Page Down 

Back  Shift Left Arrow 

Forward  Shift Right Arrow 

Set Bookmark F10 

Go To Bookmark F9 

Sentence Search S 

Burst Repeat , 

Burst Forward . 

Manual Forward Right Arrow 

Manual Back Left Arrow 

Manual Timer On/Off Toggle T 
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Positioning Methods 
 

Positioning Methods Overview 
 

There are several ways to move to locations in the document. 

 

Text Slider: 

  

Use this slider bar to adjust your current position in the document. This is useful for moving to approximate 
locations (i.e. you may want to position to the middle of the document, then search for a word or sentence). 

 

Page Back: 

  

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll back one word Set. 

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll back one page. 

 

Page Forward: 

  

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll forward one  word 
Set.  

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll forward one page. 

 

Back: 

  

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll the first word back 
one word. This is useful for fine-tuning your position when Setting Bookmarks. 

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll back one line (defined 
by new lines in the input source). 

 

Forward: 

  

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll the first word forward 
one word. This is useful for fine-tuning your position when Setting Bookmarks. 

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll forward one line 
(defined by new lines in the input source). 

 

Go To Bookmark: 

  

Click this button to move to a Bookmark. 

Note: For more details on using Bookmarks, refer to: Using Bookmarks. 

 

Sentence Search: 

  

Click this button to move to the beginning of the next sentence containing the word(s) entered in the  

 text box. 
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Using Bookmarks 
 

Bookmarks allow you to mark certain places within the text so you can return to those locations quickly and easily. 

 

Set Bookmarks: 

  

Click this button to set a Bookmark at the current location. You will be prompted for a Bookmark name. 

Note: The Scroll 1st Word Back and Scroll 1st Word Forward buttons  are helpful for exact positioning when 
Setting Bookmarks. 

 

Go To Bookmarks: 

  

Click this button to go to a previously set Bookmark. If there is only one Bookmark in the current document, you will 
be positioned to that Bookmark. If more than one Bookmark exists, you will be presented with a list from which to 
select. 

 

Load File and Go to Bookmark: 

Click the File menu item: Load File and Go to Bookmark. This function allows you to load a file and to position to 
the Bookmark of your choice. 

 

Removing Bookmarks: 

Click the File menu item: Remove Bookmarks. This function allows you to remove Bookmarks. 
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How to Load/Save Reading Material 
 

How to Load/Save Reading Material Overview 
 

Load File:  

Click the File menu item: Load File. This function allows you to load files from your hard drive. You can load plain 
text files (*.txt files) and also .pdf and .doc files. 

Note: The best way to load material that is not a .txt, .pdf or .doc format is to use the use the Load Clipboard 
function. The clipboard makes it possible to load e-mail, Web pages and text from any other application that 
supports Copy and Paste operations via the clipboard. 

Note: The bottom of the File menu allows you to load any of the last five files you previously loaded. 

Note: You may want to check out http://www.stepware.com/etext.html for links to e-text and e-books. 

Note: You can load graphics files. Refer to Administration “Graphic Files Support” section. 

 

Load Clipboard:  

Click the File menu item: Load Clipboard. This function allows you to load AceReader Elite with the contents of the 
clipboard. You can use the clipboard as a tool to read new and interesting material. This simple but powerful 
feature allows you to load text from other applications (i.e. your favorite word processor, Web browser, e-mail 
client, etc.). 

Note: For a detailed explanation on how to use the clipboard, see the Using the Clipboard section. 

Note: You may want to check out http://www.stepware.com/etext.html for links to e-text and e-books. 

 

Save As: 

Click the File menu item: Save As This function allows you to save any text you loaded into AceReader Elite via the 
Load Clipboard function to your hard disk or to a floppy or flash drive. You can then use the Load File function to 
reload the text at a later time.  

Note: You will not want to overwrite existing text files (unless they were created by a previous AceReader Elite 
Save As function) since those files will lose their original text formatting. When you save files using AceReader 
Elite, you should use them with AceReader Elite only. 

 

Load e-Book: 

Click the File menu item: Load e-book. This function allows you to load e-books that come with the program. Note: 
You can also refer to our “Resources” section at www.acereader.com for additional e-books that you can download 
from the Internet.  

 

Load Drill Text: 

Click the File menu item: Load Drill Text. This function allows you to load reading material. While the material is 
typically used when performing Drills, this function provides a way of loading the material without performing formal 
Drills.  

Note: You create Drill Text using the Drill Text Editor. 

Note: The entries with the # character were provided at program install time; you cannot edit or delete them. 

 

Load Comprehension Test Story: 

Click the File menu item: Load Comprehension Test Story. This function allows you to load Comprehension Test 
stories. While the stories are typically used when taking Comprehension Tests, this function provides a way of 
loading the material without taking formal Comprehension Tests.  

Note: You create Comprehension Test Stories using the Comprehension Test Editor. 

Note: The entries with the # character were provided at program install time; you cannot edit or delete them. 

 

Load File and Go to Bookmark: 

Click the File menu item: Load File and Go to Bookmark. This function allows you to load a file that already has 
Bookmarks and it will automatically position the text to the Bookmark of your choice. Refer to the section Using 
Bookmarks for more information on how to use Bookmarks. 
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Using the Clipboard 
 

The clipboard is a simple but powerful feature built into your Windows operating system. It is simply memory – a 
holding spot for data. You can use the clipboard to transfer data (i.e. text or images) from one application to another. 
Almost all applications support it, including AceReader Elite. This section provides an example of how to use the 
clipboard to transfer text from your Web browser into AceReader Elite. You should be able to follow similar instructions 
to transfer text from other applications (i.e. e-mail program, word processor, etc.). 

 

Use the following steps to copy text from your Web browser and paste it into AceReader Elite: 

 

1. Within your browser do the following: 

 

A. Select text for clipboard - You can select text in either of two ways: 
 

a) If you want to select all the text on the current Web page, go to the Edit Menu and click 
on the "Select All" option. 

 

OR 

 

b) If you just want a portion of the text on the current Web page, position your mouse at the 
beginning of the text, left-click the mouse and hold it while dragging over the text to 
highlight it. 

 

Note: At this point you have selected (highlighted) the text, but you have not placed it in the 
clipboard. 

 

B. Place selected text into clipboard - You place selected text into the clipboard in either of two 
ways (both do the same thing): 

 

a) Go to the Edit Menu and select the "Copy" option. 

 

OR 

 

b) Position your mouse over the highlighted text, right-click the mouse, then select the 
"Copy" option from the popup menu. 

 

Note: Now you have is loaded the text into the clipboard. 

 

2. Within AceReader Elite do the following: Select the Load Clipboard option from the File menu. This will paste 
the text into the program. 
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Customizing AceReader Elite 
 

Selecting Preset Options 
 

The following Preset options are available under the Preset-Options menu: 

 

Original Option Settings: 

This function allows you to reset all the options to the factory default (one word, center text mode, yellow font on 
black background, etc.). 

 

Productivity Mode Default Option Settings: 

This function provides a list of Preset productivity mode option Settings. Productivity modes are useful when you 
are trying to use AceReader Elite as a Productivity Tool. 

 

Educational Highlight/Non-Highlight Mode Default Option Settings: 

These functions provide a list of Preset educational mode option Settings. Educational modes are useful when you 
are trying to use AceReader Elite as a Self-Improvement Educational Tool. 

 

Custom Option Settings: 

This function provides a list of Preset custom options. Refer to the section Custom Options Management for more 
information on how to create your own custom options.  

Note: The entries with the # character were provided at program install time; you cannot edit or delete them. 
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Manually Setting Options 
 

Setting Up the Text Display Area 
 

The following options are available under the Options menu: 

 

Set Font and Colors: 

This function allows you to select the following: 

 Set Font: Set font, font style, font size, basic color for non-highlighted text. 

 Set Detailed Font Color: Fine tune font color for the non-highlighted text. 

 Set Background Color: Sets the color for the text display area. 

 Set Highlight Font Color: Set the highlight text font color. 

 Set Highlight Background Color: Set highlight text background color. 

 

Set Display Mode: 

This function allows you to specify the mode and amount of text that will be displayed or highlighted each time 
the text display area is updated.  

 

Note: Phrases (defined by new lines) – Refers to the amount of text between new lines from within the input 
source. This provides a simple way of defining the amount of text that you want presented each time the 
screen is updated. 

 

Note: Eye Fixations – Refers to the amount of times you want to re-fixate (reposition) your eyes per line (i.e. 2 
eye fixations means two times per line and will result in the first half the line being displayed or highlighted, 
then the other half). The amount of text displayed or highlighted is always on word boundaries. Also note that 
you can adjust the line width by using the margin tabs. 

 

Note: Combine Residual at End – Refers to the residual amounts of text to be included at the end of line or 
bottom of text display area. For example, if you are displaying or highlighting 2 lines at a time and near the 
bottom of the text display you only have room for a single line, that single line will be displayed with the 
previous Set of text so that the last screen update will show 3 lines instead of 2. This way, you will never have 
less the desired number of lines displayed or highlighted at a time. 

 

Note: An attempt will always be made to display the specified number of words/lines, but because of other 
option Settings (i.e. font size, margin Settings, screen width/height, etc.), the actual number of words/lines 
displayed at one time may vary. You may need to make some of these other option Settings smaller to 
achieve your desired result. 

 

Hide/Show Top and Bottom Controls: 

This function provides a mechanism for hiding or showing the top or bottom controls. These controls will 
expand/shrink the text display area. 

Note: If you hide the top or bottom controls, you can use the hotkeys to perform hidden control actions. See 
section: Using Hotkeys for more information. 

 

Top Controls: 
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Bottom Controls: 

  

 

Stretching the Screen Size: 

This function allows you to stretch or shrink the AceReader Elite main window. To accomplish this: 

1. Position the mouse to one of the AceReader Elite main window edges until the mouse icon turns to a double 
arrow. 

2. While the mouse is a double arrow, left click the mouse button and keep it pressed down. 

3. Move the mouse to expand or shrink the window.  
Note: There is a limit to how much you can shrink the window, but you can expand it to the full size of your 
monitor. 

 

Margin Settings: 

The Margin Tabs enable you to set the width of the text display area.  

Note: Text will attempt to stay inside the margins. The only time text will show up outside the margin Setting is 
when a single word is wider than the margin width. 

 

Margin Tabs: 
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Setting Text Flash Rate 
 

The rate that text is flashed on the screen will depend on your speed and fine tune speed option Settings. 

Note: The Target Speed and the Last Actual Speed may differ for several reasons: You may have adjusted your speed 
while the text was flashing; you may have pressed the Stop button early (causing the timer to stop early); or you may 
have Set the fine tune speed options. In addition, your computer’s CPU; character vs. word-based speed Settings; and 
programs running in the background can all affect speed. 

 

Front Screen Speed Control: 

  

You can click on the speed bar or use the scroll slider bar. Moving the slider bar is the same as clicking on the 
speed bar. Clicking on the left and right arrows allow you to adjust the speeding in terms of single speed units. 

Note: Refer to the Speed Options for configuring this front screen speed control. You can configure the low, high 
and current target speeds. 

Note: You will want to display more text on the screen (refer to Specify Number of Words or Lines) as you increase 
the speed. For example, when flashing one word at a time, you may want to keep your speed below 700 WPM. 
When flashing two words at a time, you may want to keep your speed below 800 WPM. You should be flashing full 
lines when attempting to go at higher speeds (i.e. 900 WPM). 

 

Speed Options: 

This function allows you to configure the front screen speed control. You can specify: 

 Target Speed units: WPM (Words per Minute), CPS (Characters per Second) or CPM (Characters per Minute). 
You may want to use a character-based speed if you want long words to display longer than short words.  
 
Note: If you select a character-based speed, you will probably want to set the Flash rate delay to "Variable."  
See the Set Delays menu item for setting the Variable/Fixed Flash Rates option for more information. 

 Low Speed: The speed value of the lowest speed bar on the front screen. 

 High Speed: The speed value of the highest speed bar on the front screen. 

 Current Speed: The current target speed Setting.  
 
Note: You can adjust this value from the front screen by clicking on the speed bars and/or using the speed slider 
bar. 
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Fine Tune Speed Options: 

 

These options allow you to fine tune your speed (rate at which the text display area is updated).  

 

Fixed Rate:  

Set the flash (or text display update) rate to be constant.  

 

The flash rate is determined from the first few flashes and will vary depending on the speed and the amount of 
text being displayed.  

 

Since the amount of text shown in each screen update can vary, your reading speed should also vary if you 
want to maintain your Target Speed. There are several reasons why the amount of text shown in each screen 
update may vary. For example, you may be flashing three lines per screen update, but when the flashing text 
reaches the bottom of the text display area there is only enough room to show two lines. In addition, font size 
setting, margin width Settings, text display area size and word lengths can all affect the amount of text shown. 

 

Note: You probably don’t want this option Set if you are using a "character based" speed Setting (i.e. CPS or 
CPM ) since character based speeds are designed to vary the speed depending on the number of characters 
shown on each display update. 

 

Long Word Delays:  

Delay a specified number of milliseconds (ms) if words are encountered that contain the specified number of 
characters. 

 

Sentence Ending Delays:  

Delay a specified number of milliseconds (ms) if an end of sentence punctuation mark is encountered. 

 

Punctuation Delays:  

Delay a specified number of milliseconds (ms) if a punctuation mark is encountered. 

 

Beginning of Line Delays:  

Delay a specified number of milliseconds (ms) when displaying or highlighting the beginning of a line. This 
provides time for your eyes to reposition from the end of the previous line to the beginning of the next line. 

 

Beginning of Page Delays:  

Delay a specified number of milliseconds (ms) when displaying or highlighting the beginning of a page (text 
that fits on text display area). This provides time for your eyes to reposition from the bottom of the text display 
area to the top. 

 

Minimum Delay:  

Ensure that the text is always shown for a minimum amount of time. This is useful in cases where a small 
amount of text is shown and you don’t want it to flash by too fast. 

 

 

Note: The Target Speed and the Last Actual Speed may differ for several reasons: You may have adjusted your 
speed while the text was flashing; you may have pressed the Stop button early (causing the timer to stop early); or 
you may have fine tune speed options Set. In addition, your computer’s CPU; character vs. word-based speed 
Settings; and programs running in the background can all affect speed. 
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Setting Burst Options 
 

For a general usage description of how to use the Burst buttons on the front screen, refer to the How to Start and Stop 
Flashing Text section. 

 

Set Burst Options: 

This Options Menu function allows you to specify the amount of text that is displayed or highlighted before 
stopping. You can specify the amount of text in terms of: (1) Sentences, (2) Words, (3) Phrases, (4) Flashes 
(or screen updates). 

 

Phrases can refer to several different text segments. They can refer to: 

 The amount of text between new lines from the input source. 

 The amount of text between shown on each display line (when in a highlighting mode). 

 The amount of text between punctuation marks.  
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Mapping Your Own Hotkeys 
 

Hotkeys enable you to access commonly used functions using a series of keystrokes rather than using the mouse. For 
a general usage and default hotkey definitions, refer to: Using Hotkeys.  

 

Map Keys: 

This Options Menu function allows you to assign (map) keyboard keys to common functions. You will need to 
highlight a function and a Key and then press the "Map Selected Function with Selected Key" button. 
 

Note: You can return all the hotkeys back to their defaults by clicking on the "Reset All" button. 
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Menu Quick Reference 

 

Menu Quick Reference Overview 
 

The AceReader Elite menu command reference section provides a comprehensive listing of each menu item. It is not 
intended as a comprehensive how-to for each menu command, but rather as a quick reference. You will find the 
following information for each menu command: 

 

Menu Item: Name of the menu item. 

Purpose: A short description of the menu item’s purpose. 

How to Access: The series of mouse clicks, along with possible keyboard 
shortcuts, used to invoke the menu command. 

See Also: Related help topics that indicate where to go to find more details 
on how to use the functionality of this menu item and why. 

 

 

File Menu Quick Reference 

Load File Menu Item Quick Reference (PC Version) 
 

Menu Item: Load File 

Purpose: Enables you to load files from your hard drive into AceReader 
Elite. 

How to Access: Click File menu 

Click Load File 

Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen 
with tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How To Load/Save Reading Material Overview  

 

Open File Menu Item Quick Reference (Mac Version) 
 

Menu Item: Open File 

Purpose: Enables you to load files from a disk into AceReader Elite. 

How to Access: Click File menu 

Click Open File 

Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen 
with tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How To Load/Save Reading Material Overview  

 

 Open Recent Menu Item Quick Reference (Mac Version) 
 

Menu Item: Open Recent 

Purpose: Enables you to load files from a disk into AceReader Elite. 
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How to Access: Click File menu 

Click Open Recent 

Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen 
with tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Load/Save Reading Material Overview  

 

Load Clipboard Menu Item Quick Reference (PC Version) 
 

Menu Item: Load Clipboard (Paste) 

Purpose: Enables you to load the contents of the clipboard into AceReader 
Elite. Otherwise Known as a paste operation. 

How to Access: 
 

Click File menu 

Click Load Clipboard (Paste) 

Note: Programmable hotkey (default is Control V) 

Note: To have access to this menu item, you must be in the “Reading 
Mode” screen. If you are on the Main Screen (screen with tabs), click 
on the “Reading Mode” tab and click on the “Enter Reading Mode” 
button. 

See Also:  How to Load/Save Reading Material Overview  
Using the Clipboard  
Using Hotkeys  
Mapping Your Own Hotkeys 
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Save As Menu Item Quick Reference 
 

Menu Item: Save As 

Purpose: Enables you to save the currently loaded document to a file.  

How to Access: Click File menu 
Click Save As 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Load/Save Reading Material Overview 

 

Load e-book 
 

Menu Item: Load e-book 

Purpose: Enables you to load e-books that come with the program. Note: You 
can also refer to our “Resources” section at www.acereader.com for 
additional e-books that you can download from the Internet. 

How to Access: Click File menu 
Click e-book 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Load/Save Reading Material Overview 

 

Load Drill Text Menu Item Quick Reference 
 

Menu Item: Load Drill Text 

Purpose: Enables you to load Drill Text created using the Drill Text Editor so 
that you can read the text without performing a formal Drill. 

How to Access: Click File menu 
Click Load Drill Text 

Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Load/Save Reading Material Overview  

 

 

Load Comprehension Test Story Menu Item Quick Reference 
 

Menu Item: Load Comprehension Test Story 
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Purpose: Enables you to load stories created using the Comprehension Test 
Editor so that you can read the story without taking the 
Comprehension Test. 

How to Access: Click File menu 
Click Load Comprehension Test Story 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Load/Save Reading Material Overview 
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Load File and Go To Bookmark Menu Item Quick Reference 
 

Menu Item: Load File and Go to Bookmark 

Purpose: Enables you to load a file and move to a Bookmark position. 

How to Access: Click File menu 
Click Load File and Go To Bookmark 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Load/Save Reading Material Overview  
Using Bookmarks 

 
 

 

Remove Bookmarks Menu Item Quick Reference 
 

Menu Item: Remove Bookmarks 

Purpose: Enables you to remove Bookmarks associated with files. 

How to Access: Click File menu 
Click Remove Bookmarks 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Using Bookmarks 

 

Logon As Menu Item Quick Reference 
 

Menu Item: Log on As 

Purpose: Enables you to log on to AceReader Elite under a different name.  
Program Settings and Test scores are kept separate for each User. 

How to Access: Click File menu 
Click Logon As 

See Also: Logging On and Adding Users  

 

 

Exit Menu Item Quick Reference (PC Version) 
 

Menu Item: Exit 

Purpose: Enables you to close down the AceReader Elite program. 

How to Access: Click File menu 
Click Exit 
 
Note: To have access to this menu item, you must be in the 
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“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: n/a 

 

Quit Menu Item Quick Reference (Mac Version) 
 

Menu Item: Quit 

Purpose: Enables you to close down the AceReader Elite program. 

How to Access: Click File menu 
Click Quit 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: n/a 

 

Edit Menu Quick Reference (Mac Version) 

Paste Menu Item Quick Reference (Mac Version) 
 

Menu Item: Paste 

Purpose: Enables you to paste previously copied text into AceReader Elite 
program. 

How to Access: Click Edit menu 
Click Paste 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: n/a 

 

 

 

Options Menu Quick Reference 
 

Set Font and Colors 
 

Menu Item: Set Font and Colors 

Purpose: Enables you to select the font and colors AceReader Elite will use 
when flashing text. 

How to Access: Click Options menu 
Click Set Font and Colors 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Setting Up the Text Display Area 



AceReader Elite Manual 

46 

 

Set Display Mode 
 

Menu Item: Set Display Mode 

Purpose: Enables you to Set the text display mode. 

How to Access: Click Options menu 
Click Set Display Mode 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Setting Up the Text Display Area 

 

 

Set Speed Options 
 

Menu Item: Set Speed Options 

Purpose: Enables you to Set up the front screen speed control by Setting the 
low, high and target speeds in terms of WPM, CPS or CPM. 

How to Access: Click Options menu 
Click Set Speed Options 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Setting Text Flash Rate  
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Set Fine Tune Speed Options 
 

Menu Item: Set Fine Tune Speed Options 

Purpose: Enables you to Set fixed speed and delays that will affect the rate at 
which text is flashed on the screen. 

How to Access: Click Options menu 
Click Set Fine Tune Speed Options 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Setting Text Flash Rate  

 

 

Set Burst Options Menu Item Quick Reference 
 

Menu Item: Set Burst Options 

Purpose: Enables you to Set the amount of text to display before stopping 
when using the Burst buttons on the main screen. 

How to Access: Click Options menu 
Click Set Burst Options 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: How to Start and Stop Flashing Text  
Setting Burst Options 

 

 

Map Keys Menu Item Quick Reference 
 

Menu Item: Map Keys 

Purpose: Enables you to map keyboard keys to commonly used functions. 

How to Access: Click Options menu 
Click Map Keys 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Mapping Your Own Hotkeys  
Using Hotkeys 
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Hide/Show Top Controls Menu Item Quick Reference 
 

Menu Item: Hide/Show Top Controls 

Purpose: Enables you to hide or show the top controls. 

How to Access: Click Options menu 
Click Hide Top Controls or Show Top Controls 
 
Note: Programmable hotkey (default is F11) 

Note: Icon on main screen.   (use top icon) 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Setting Up the Text Display Area  
Using Hotkeys  
Mapping Your Own Hotkeys 

 

 

Hide/Show Bottom Controls Menu Item Quick Reference 
 

Menu Item: Hide/Show Bottom Controls 

Purpose: Enables you to hide or show the bottom controls. 

How to Access: Click Options menu 
Click Hide Bottom Controls or Show Bottom Controls 
 
Note: Programmable hotkey (default is F12) 

Note: Icon on main screen.   (use bottom icon) 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Setting Up the Text Display Area  
Using Hotkeys  
Mapping Your Own Hotkeys 

 

 

 

Preset-Options Menu Quick Reference 

Original Option Settings Menu Item Quick Reference 
 

Menu Item: Original Option Settings 

Purpose: Enables you to reset all the options to factory default.  

How to Access: Click Preset-Options menu 
Click Original Option Settings 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 
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See Also: Selecting Preset Options 
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Productivity Mode Default Option Settings Menu Item Quick Reference 
 

Menu Item: Productivity Mode Default Option Settings 

Purpose: Enables you to select from a list of pre-configured options Settings 
designed for Productivity use. 

How to Access: Click Preset-Options menu 
Click Productivity Mode Default Option Settings 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Selecting Preset Options 

 

 

Educational Highlight Mode Default Option Settings 
 

Menu Item: Educational Highlight Mode Default Option Settings 

Purpose: Enables you to select from a list of pre-configured options Settings 
designed for Educational use that utilize highlighting. 

How to Access: Click Preset-Options menu 
Click Educational Highlight Mode Default Option Settings 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Selecting Preset Options 

 

 

Educational Non-Highlight Mode Default Option Settings 
 

Menu Item: Educational Non-Highlight Mode Default Option Settings 

Purpose: Enables you to select from a list of pre-configured options Settings 
designed for Educational use. 

How to Access: Click Preset-Options menu 
Click Educational Non-Highlight Mode Default Option Settings 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Selecting Preset Options  
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Custom Option Settings Menu Item Quick Reference 
 

Menu Item: Custom Option Settings 

Purpose: Enables you to select a custom option. 

How to Access: Click Preset-Options menu 
Click Custom Option Settings 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Selecting Preset Options  
Custom Options Management 
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Tests-Drills-Games Menu Quick Reference 
 

Take Comprehension Test (Self-Paced) Menu Item Quick Reference 
 

Menu Item: Take Comprehension Test (Self-Paced) 

Purpose: Enables you to take a Self-Paced reading Comprehension Test. 

How to Access: Click Tests-Drills-Games menu 
Click Take Comprehension Test (Self-Paced) 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Take Comprehension Test (Self-Paced)  
Take Comprehension Test (Forced Speed/Mode) 

 

 

Take Comprehension Test (Forced Speed/Mode) Menu Item Quick Reference 
 

Menu Item: Take Comprehension Test (Forced Speed/Mode) 

Purpose: Enables you to take a reading Comprehension Test. Text 
presentation speed and mode are pre-determined before taking the 
Test. 

How to Access: Click Tests-Drills-Games menu 
Click Take Comprehension Test (Forced Speed/Mode) 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Take Comprehension Test (Forced Speed/Mode)  
Take Comprehension Test (Self-Paced) 

 

 

View Comprehension Test Results Menu Item Quick Reference 
 

Menu Item: View Comprehension Test Results 

Purpose: Enables you to view the results of your Comprehension Tests. 

How to Access: Click Tests-Drills-Games menu 
Click View Comprehension Test Results 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: View Comprehension Test Results 
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Perform Warm-Up Drills Menu 
 

Menu Item: Perform Warm-Up Drills 

Purpose: Enables you to perform Warm-Up Drills. 

How to Access: Click Tests-Drills-Games menu 
Click Perform Warm-Up Drills 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Perform Warm-Up Drills 

 

 

Perform Drills Menu Item Quick Reference 
 

Menu Item: Perform Drills 

Purpose: Enables you to perform Drills. 

How to Access: Click Tests-Drills-Games menu 
Click Perform Drills 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Performing Drills 

 

 

Play Eye-Span Game Menu Item Quick Reference 
 

Menu Item: Play Eye-Span Game 

Purpose: The Eye-Span Game will help you: (1) Reduce Your Eye Fixation 
Time (time spent when your eyes are focused on a single point); (2) 
Expand Your Eye Fixation Zone (ability to read a wider text width 
when your eyes are focused on a single point); and (3) Increase 
Your Re-Fixation Speed (ability to reposition your eyes at a rapid 
rate). These are skills that are required to become a proficient 
reader. 

How to Access: Click Tests-Drills-Games menu 
Click Play Eye-Span Game 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Play Eye-Span Game  

Play Eye-Span Comprehension Game  

Play Tachistoscope Flash & Recall Game  

Play Flash Card Game  
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Play Search/Scan Game 

 

Play Eye-Span Comprehension Game Menu Item Quick Reference 
 

Menu Item: Play Eye-Span Comprehension Game 

 

Purpose: The Eye-Span Comprehension Game is similar to the Eye-Span 
Game except it has a "Comprehension" element to it. It will help you 
increase your eye span and eye fixation speed while you are also 
being forced to think about the meaning of the words flashed on the 
screen. 

How to Access: Click Tests-Drills-Games menu 
Click Play Eye-Span Comprehension Game 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Play Eye-Span Game  

Play Eye-Span Comprehension Game  

Play Tachistoscope Flash & Recall Game  

Play Flash Card Game  

Play Search/Scan Game  

 

 

Play Tachistoscope Flash & Recall Game Menu 
 

Menu Item: Play Tachistoscope Flash & Recall Game 

Purpose: The Tachistoscope Flash & Recall Game will flash text for a short 
period of time. You will then need to recall the text that was flashed. 
This Game helps demonstrate how fast you are able to read when 
presented with a short burst of text. It also increases your eye span 
and eye fixation speed. 

How to Access: Click Tests-Drills-Games menu 
Click Play Tachistoscope Flash & Recall Game 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Play Eye-Span Game  

Play Eye-Span Comprehension Game  

Play Tachistoscope Flash & Recall Game  

Play Flash Card Game  

Play Search/Scan Game 
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Play Search/Scan Game Menu 
 

Menu Item: Play Search/Scan Game 

Purpose: With the Search/Scan Game, you will search for a pre-specified 
word or symbol within a list or body of text. Searching/Scanning is 
something we do many times in our daily lives (i.e. looking up phone 
numbers, recipe ingredients, research...) and the Game can help 
you become more skilled at this common daily activity. 

How to Access: Click Tests-Drills-Games menu 
Click Play Search/Scan Game 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Play Eye-Span Game  

Play Eye-Span Comprehension Game  

Play Tachistoscope Flash & Recall Game  

Play Flash Card Game  

Play Search/Scan Game 

 

 

Play Flash Card Game Menu 
 

Menu Item: Play Flash Card Game 

Purpose: The Flash Card Game is similar to the Tachistoscope Flash & Recall 
Game except it has a "Comprehension" element to it. You can also 
use it to memorize learning materials such as Times Tables, State 
Capitals... Note: As with all the Tests, Drills and Games, the 
Administration functions allow you to incorporate your own practice 
material into the program. 

How to Access: Click Tests-Drills-Games menu 
Click Play Flash Card Game 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Play Eye-Span Game  

Play Eye-Span Comprehension Game  

Play Tachistoscope Flash & Recall Game  

Play Flash Card Game  

Play Search/Scan Game 
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Take Course 
 

Menu Item: Take Course 

Purpose: To step you through each step of the training process. It consists of 
activities which include Setting your Base Reading Speed (BRS), 
taking periodic timed Reading Comprehension Tests, performing 
Warm-Up Drills, performing other Drills and playing eye exercise 
Games. 

How to Access: Click Tests-Drills-Games menu 
Click Take Course 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Course Mode Overview  
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Admin Menu Quick Reference 
 

User Management 

Add Users 
 

Menu Item: Add Users 

Purpose: Enables the Teacher or Administrator to add Users. Passwords can 
optional by specified. If importing User list, User/class associations 
can be assigned. 

How to Access: Click Admin menu 
Click User Management sub-menu 
Click Add Users 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management  

 

 

 

Assign Users to Classes Menu Item Quick Reference 
 

Menu Item: Assign Users to Classes 

Purpose: Enables the Teacher or Administrator to create classes and to 
assign Users to those classes. 

How to Access: Click Admin menu 
Click User Management sub-menu 
Click Assign Users to Classes 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management  

 

 

Remove User Menu Item Quick Reference 
 

Menu Item: Remove User 

Purpose: Enables the Teacher or Administrator to remove Users. 

How to Access: Click Admin menu 
Click User Management sub-menu 
Click Remove User 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 
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See Also: User Management  
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Remove User Password Menu Item Quick Reference 
 

Menu Item: Remove User Password 

Purpose: Enables the Teacher or Administrator to remove a User’s password.  

How to Access: Click Admin menu 
Click User Management sub-menu 
Click Remove User Password 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management  

 

 

User Logons Menu Item Quick Reference (Network Version Only) 
 

Menu Item: User Logons 

Purpose: Enables the Teacher or Administrator to view who is logged on and 
to log off Users. 

How to Access: Click Admin menu 
Click User Management sub-menu 
Click User Logons 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management  

 

 

 

View User Comprehension Test Results Menu Item Quick Reference 

 

Menu Item: View User Comprehension Test Results 

Purpose: Enables the Teacher or Administrator to view User Comprehension 
Test Results. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click View User Comprehension Test Results 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management  
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Clear Individual or All User Comprehension Test Results Menu Item Quick Reference 
 

Menu Item: Clear Individual or All User Comprehension Test Results 

Purpose: Enables the Teacher or Administrator to clear User Comprehension 
Test Results. 

How to Access: Click Admin menu 
Click User Management sub-menu 
Click Clear Individual or All User Comprehension Test Results 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management 

 

 

 

Export User Comprehension Test Results Menu Item Quick Reference 
 

Menu Item: Export User Comprehension Test Results 

Purpose: Enables the Teacher or Administrator to export User 
Comprehension Test Results. 

How to Access: Click Admin menu 
Click User Management sub-menu 
Click Export User Comprehension Test Results 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: User Management 

 

 

 



Using AceReader Elite 

61 

Comprehension Test Management 
 

Comprehension Test Editor Menu Item Quick Reference 
 

Menu Item: Comprehension Test Editor 

Purpose: Enables the Teacher or Administrator to create and edit 
Comprehension Tests for any existing Comprehension Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Comprehension Test Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  

 

 

Remove Comprehension Test Menu Item Quick Reference 
 

Menu Item: Remove Comprehension Test  

Purpose: Enables the Teacher or Administrator to remove Comprehension 
Test from an existing Comprehension Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Remove Comprehension Test  
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  

 

 

 

Create New Comprehension Test Set Menu Item Quick Reference 
 

Menu Item: Create New Comprehension Test Set 

Purpose: Enables the Teacher or Administrator to create a new 
Comprehension Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Create New Comprehension Test Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  
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Duplicate Comprehension Test Set Menu Item Quick Reference 
 

Menu Item: Duplicate New Comprehension Test Set 

Purpose: Enables the Teacher or Administrator to duplicate an existing 
Comprehension Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Duplicate Comprehension Test Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  

 

 

Remove Comprehension Test Set Menu Item Quick Reference 
 

Menu Item: Remove Comprehension Test Set 

Purpose: Enables the Teacher or Administrator to remove an existing 
Comprehension Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Remove Comprehension Test Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  

 

 

Import Comprehension Test Set Menu Item Quick Reference 
 

Menu Item: Import Comprehension Test Set 

Purpose: Enables the Teacher or Administrator to import a Comprehension 
Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Import Comprehension Test Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  
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Export Comprehension Test Set 
 

Menu Item: Export Comprehension Test Set 

Purpose: Enables the Teacher or Administrator to export a Comprehension 
Test Set. 

How to Access: Click Admin menu 
Click Comprehension Test Management sub-menu 
Click Export Comprehension Test Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Comprehension Test Management  
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Eye-Span Game Text Management 
 

Eye Span Game Text Editor 
 

Menu Item: Eye Span Game Text Editor 

Purpose: Enables the Teacher or Administrator to create and edit text to be 
used with the Eye-Span Game. 

How to Access: Click Admin menu 
Click Eye Span Game Text Management sub-menu 
Click Eye Span Game Text Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management  

 

 

Remove Eye-Span Game Text 
 

Menu Item: Remove Eye Span Game Text 

Purpose: Enables the Teacher or Administrator to remove Eye-Span Game 
text. 

How to Access: Click Admin menu 
Click Eye Span Game Text Management sub-menu 
Click Remove Eye Span Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

 

Import Eye-Span Game Text 
 

Menu Item: Import Eye Span Game Text 

Purpose: Enables the Teacher or Administrator to import Eye-Span Game 
text. 

How to Access: Click Admin menu 
Click Eye Span Game Text Management sub-menu 
Click Import Eye Span Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Export Eye-Span Game Text 
 

Menu Item: Export Eye Span Game Text 

Purpose: Enables the Teacher or Administrator to export Eye-Span Game 
text. 

How to Access: Click Admin menu 
Click Eye Span Game Text Management sub-menu 
Click Export Eye Span Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management  
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Eye-Span Comprehension Game Text Management 
 

Eye-Span Comprehension Game Text Editor 
 

Menu Item: Eye Span Comprehension Game Text Editor 

Purpose: Enables the Teacher or Administrator to create and edit text to be 
used with the Eye-Span Comprehension Game. 

How to Access: Click Admin menu 
Click Eye Span Comprehension Game Text Management sub-
menu 
Click Eye Span Comprehension Game Text Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

Remove Eye-Span Comprehension Game Text 
 

Menu Item: Remove Eye Span Comprehension Game Text 

Purpose: Enables the Teacher or Administrator to remove Eye-Span 
Comprehension Game text. 

How to Access: Click Admin menu 
Click Eye Span Comprehension Game Text Management sub-
menu 
Click Remove Eye Span Comprehension Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

 

Import Eye-Span Comprehension Game Text 
 

Menu Item: Import Eye Span Comprehension Game Text 

Purpose: Enables the Teacher or Administrator to import Eye-Span 
Comprehension Game text. 

How to Access: Click Admin menu 
Click Eye Span Comprehension Game Text Management sub-
menu 
Click Import Eye Span Comprehension Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 



Using AceReader Elite 

67 

tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Export Eye-Span Comprehension Game Text 
 

Menu Item: Export Eye Span Comprehension Game Text 

Purpose: Enables the Teacher or Administrator to export Eye-Span 
Comprehension Game text. 

How to Access: Click Admin menu 
Click Eye Span Comprehension Game Text Management sub-
menu 
Click Export Eye Span Comprehension Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Tachistoscope Flash and Recall Game Text Management 
 

Tachistoscope Flash and Recall Game Text Editor 
 

Menu Item: Tachistoscope Flash and Recall Game Text Editor 

Purpose: Enables the Teacher or Administrator to create and edit text to be 
used with the Tachistoscope Flash and Recall Game. 

How to Access: Click Admin menu 
Click Tachistoscope Flash and Recall Game Text Management 
sub-menu 
Click Tachistoscope Flash and Recall Game Text Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

Remove Tachistoscope Flash and Recall Game Text 
 

Menu Item: Remove Tachistoscope Flash and Recall Game Text 

Purpose: Enables the Teacher or Administrator to remove Tachistoscope 
Flash and Recall Game text. 

How to Access: Click Admin menu 
Click Tachistoscope Flash and Recall Game Text Management 
sub-menu 
Click Remove Tachistoscope Flash and Recall Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

Import Tachistoscope Flash and Recall Game Text 
 

Menu Item: Import Tachistoscope Flash and Recall Game Text 

Purpose: Enables the Teacher or Administrator to import Tachistoscope Flash 
and Recall Game text. 

How to Access: Click Admin menu 
Click Tachistoscope Flash and Recall Game Text Management 
sub-menu 
Click Import Tachistoscope Flash and Recall Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
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Reading Mode” button. 

See Also: Game Text Management 
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Export Tachistoscope Flash and Recall Game Text 
 

Menu Item: Export Tachistoscope Flash and Recall Game Text 

Purpose: Enables the Teacher or Administrator to export Tachistoscope Flash 
and Recall game text. 

How to Access: Click Admin menu 
Click Tachistoscope Flash and Recall Game Text Management 
sub-menu 
Click Export Tachistoscope Flash and Recall Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Search/Scan Game Text Management 
 

Search/Scan Game Text Editor 
 

Menu Item: Search/Scan Game Text Editor 

Purpose: Enables the Teacher or Administrator to create and edit text to be 
used with the Search/Scan Game. 

How to Access: Click Admin menu 
Click Search/Scan Game Text Management sub-menu 
Click Search/Scan Game Text Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

Remove Search/Scan Game Text 
 

Menu Item: Remove Search/Scan Game Text 

Purpose: Enables the Teacher or Administrator to remove Search/Scan Game 
text. 

How to Access: Click Admin menu 
Click Search/Scan Game Text Management sub-menu 
Click Remove Search/Scan Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

Import Search/Scan Game Text 
 

Menu Item: Import Search/Scan Game Text 

Purpose: Enables the Teacher or Administrator to import Search/Scan Game 
text. 

How to Access: Click Admin menu 
Click Search/Scan Game Text Management sub-menu 
Click Import Search/Scan Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Export Search/Scan Game Text 
 

Menu Item: Export Search/Scan Game Text 

Purpose: Enables the Teacher or Administrator to export Search/Scan Game 
text. 

How to Access: Click Admin menu 
Click Search/Scan Game Text Management sub-menu 
Click Export Search/Scan Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Flash Card Game Text Management 
 

Flash Card Game Text Editor 
 

Menu Item: Flash Card Game Text Editor 

Purpose: Enables the Teacher or Administrator to create and edit text to be 
used with the Flash Card Game. 

How to Access: Click Admin menu 
Click Flash Card Game Text Management sub-menu 
Click Flash Card Game Text Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

Remove Flash Card Game Text 
 

Menu Item: Remove Flash Card Game Text 

Purpose: Enables the Teacher or Administrator to remove Flash Card Game 
text. 

How to Access: Click Admin menu 
Click Flash Card Game Text Management sub-menu 
Click Remove Flash Card Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 

 

 

 

Import Flash Card Game Text 
 

Menu Item: Import Flash Card Game Text 

Purpose: Enables the Teacher or Administrator to import Flash Card Game 
text. 

How to Access: Click Admin menu 
Click Flash Card Game Text Management sub-menu 
Click Import Flash Card Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Export Flash Card Game Text 
 

Menu Item: Export Flash Card Game Text 

Purpose: Enables the Teacher or Administrator to export Flash Card Game 
text. 

How to Access: Click Admin menu 
Click Flash Card Game Text Management sub-menu 
Click Export Flash Card Game Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Game Text Management 
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Custom Options Management 
 

Add Custom Option Setting Menu Item Quick Reference 
 

Menu Item: Add Custom Option Setting 

Purpose: Enables the Teacher or Administrator to add Custom Options 
Settings to an existing Custom Options Set. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Add Custom Option Setting 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management 

 

 

Remove Custom Option Setting Menu Item Quick Reference 
 

Menu Item: Remove Custom Option Setting 

Purpose: Enables the Teacher or Administrator to remove Custom Options 
Settings from an existing Custom Options Set. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Remove Custom Option Setting 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management 

 

 

Create New Custom Options Set Menu Item Quick Reference 
 

Menu Item: Create New Custom Options Set 

Purpose: Enables the Teacher or Administrator to create a new Set of Custom 
Options. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Create New Custom Options Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management 
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Duplicate Custom Options Set Menu Item Quick Reference 
 

Menu Item: Duplicate Custom Options Set 

Purpose: Enables the Teacher or Administrator to duplicate an existing 
Custom Options Set. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Duplicate Custom Options Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management  

 

 

Remove Custom Options Set Menu Item Quick Reference 
 

Menu Item: Remove Custom Options Set 

Purpose: Enables the Teacher or Administrator to remove an existing Custom 
Options Set. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Remove Custom Options Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management  

 

 

Import Custom Options Set Menu Item Quick Reference 
 

Menu Item: Import Custom Options Set 

Purpose: Enables the Teacher or Administrator to import a Custom Options 
Set. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Import Custom Options Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management  
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Export Custom Options Set Menu Item Quick Reference 
 

Menu Item: Export Custom Options Set 

Purpose: Enables the Teacher or Administrator to export a Custom Options 
Set. 

How to Access: Click Admin menu 
Click Custom Options Management sub-menu 
Click Export Custom Options Set 

Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Custom Options Management  
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Drill Text Management 
 

Drill Text Editor Menu Item Quick Reference 
 

Menu Item: Drill Text Editor 

Purpose: Enables the Teacher or Administrator to create and edit Drill text for 
any existing Drill Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Drill Text Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Editor  

 

 

Remove Drill Text Menu Item Quick Reference 
 

Menu Item: Remove Drill Text 

Purpose: Enables the Teacher or Administrator to remove Drill text from an 
existing Drill Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Remove Drill Text 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Management  

 

 

Create New Drill Text Set Menu Item Quick Reference 
 

Menu Item: Create New Drill Text Set 

Purpose: Enables the Teacher or Administrator to create a new Drill Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Create New Drill Text Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Management  
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Duplicate Drill Text Set Menu Item Quick Reference 
 

Menu Item: Duplicate Drill Text Set 

Purpose: Enables the Teacher or Administrator to duplicate an existing Drill 
Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Duplicate Drill Text Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Management  

 

 

Remove Drill Text Set Menu Item Quick Reference 
 

Menu Item: Remove Drill Text Set 

Purpose: Enables the Teacher or Administrator to remove an existing Drill 
Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Remove Drill Text Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Management  

 

 

Import Drill Text Set Menu Item Quick Reference 
 

Menu Item: Import Drill Text Set 

Purpose: Enables the Teacher or Administrator to import a Drill Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Import Drill Text Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Management  
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Export Drill Text Set Menu Item Quick Reference 
 

Menu Item: Export Drill Text Set 

Purpose: Enables the Teacher or Administrator to export a Drill Text Set. 

How to Access: Click Admin menu 
Click Drill Text Management sub-menu 
Click Export Drill Text Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Text Management  
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Drill Management 
 

Drill Editor Menu Item Quick Reference 
 

Menu Item: Drill Editor 

Purpose: Enables the Teacher or Administrator to create and edit Drills for 
any existing Drill Set. 

How to Access: Click Admin menu 
Click Drill Management sub-menu 
Click Drill Editor 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Management  

 

 

Create New Drill Set Menu Item Quick Reference 
 

Menu Item: Create New Drill Set 

Purpose: Enables the Teacher or Administrator to create a new Drill Set. 

How to Access: Click Admin menu 
Click Drill Management sub-menu 
Click Create New Drill Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Management  

 

 

Duplicate Drill Set Menu Item Quick Reference 
 

Menu Item: Duplicate Drill Set 

Purpose: Enables the Teacher or Administrator to duplicate an existing Drill 
Set. 

How to Access: Click Admin menu 
Click Drill Management sub-menu 
Click Duplicate Drill Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Management  
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Remove Drill Set Menu Item Quick Reference 
 

Menu Item: Remove Drill Set 

Purpose: Enables the Teacher or Administrator to remove an existing Drill 
Set. 

How to Access: Click Admin menu 
Click Drill Management sub-menu 
Click Remove Drill Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Management  

 

 

Import Drill Set Menu Item Quick Reference 
 

Menu Item: Import Drill Set 

Purpose: Enables the Teacher or Administrator to import a Drill Set. 

How to Access: Click Admin menu 
Click Drill Management sub-menu 
Click Import Drill Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Management  

 

 

Export Drill Set Menu Item Quick Reference 
 

Menu Item: Export Drill Set 

Purpose: Enables the Teacher or Administrator to export a Drill Set. 

How to Access: Click Admin menu 
Click Drill Management sub-menu 
Click Export Drill Set 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: Drill Management  
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Set Base Reading Speed Options 
 

Menu Item: Set Base Reading Speed Options 

Purpose: Allows you to filter out certain Test Results when determining your 
Base Reading Speed. 

How to Access: Click Admin menu 
Click Set Base Reading Speed Options sub-menu 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: n/a 

 

 

 

Set Personal Goal 
 

Menu Item: Set Personal Goal 

Purpose: Allows you to Set your personal reading speed Goal. This is used by 
Drills that utilize you goal speed to determine pacing speeds. When 
viewing your Test Results, the Goal Speed will also be displayed so 
that you can monitor your progress in relation to your Goal. 

How to Access: Click Admin menu 
Click Set Personal Goal sub-menu 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: n/a 
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Miscellaneous Options 
 

Miscellaneous Options 
 

Menu Item: Miscellaneous Options 

Purpose: Provides additional Administrative options. 

How to Access: Click Admin menu 
Click Miscellaneous Options sub-menu 
 
Note: To have access to this menu item, you must be in the 
“Reading Mode” screen. If you are on the Main Screen (screen with 
tabs), click on the “Reading Mode” tab and click on the “Enter 
Reading Mode” button. 

See Also: n/a 
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Help Menu Quick Reference 
 

AceReader Elite Help Menu Item Quick Reference 
 

Menu Item: AceReader Elite Help 

Purpose: Presents User with internal help documentation. 

How to Access: Click Help menu 
Click AceReader Elite Help 

See Also: n/a 

 

 

Online Help Menu Item Quick Reference (PC Version) 
 

Menu Item: Online Help 

Purpose: Displays online support Web page. 

How to Access: Click Help menu 
Click Online Help 

See Also: n/a 

 

Online Support Menu Item Quick Reference (Mac Version) 
 

Menu Item: Online Support 

Purpose: Launches AceReader’s Support Web page.  

How to Access: Click Help menu 
Click Online Support 

See Also: n/a 

 

 

Reading Mode Screen Quick Reference (PC Version) 
 

Menu Item: Reading Mode Screen Quick Reference 

Purpose: Brings up the “Home Screen” (main home screen with tabs) 
“Reading Mode” tab screen. This screen provides a quick reference 
for all the Reading Mode screen components as you move your 
mouse over the screen image.  

How to Access: Click Help menu 
Click Reading Mode Screen Quick Reference 

See Also: n/a 

 

 

Go Back to Home Screen (screen with tabs) Menu Item Quick Reference 
 

Menu Item: Go Back to Home Screen (screen with tabs) 

Purpose: Bring up main home screen. 

How to Access: Click Help menu 
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Click Go Back to Home Screen (screen with tabs) 

See Also: n/a 
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Tip of the Day Menu Item Quick Reference 
 

Menu Item: Tip of the Day 

Purpose: Displays the Tip of the Day dialog box. 

How to Access: Click Help menu 
Click Tip of the Day 

See Also: n/a 

 

 

Order Web Page Menu Item Quick Reference 
 

Menu Item: Order Web Page 

Purpose: Enables User to access the AceReader secure online order page. 

How to Access: Click Help menu 
Click Order Web Page 

See Also: Order Information  

 

 

 

About Menu Item Quick Reference (PC Version) 
 

Menu Item: About 

Purpose: Displays About dialog box that contains the program version and 
registration information.  

How to Access: Click Help menu 
Click About 

See Also: License Agreement  

Order Information  
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Administration 

 

Administration Overview 

AceReader Elite is highly customizable. Administration functions include the ability to perform User Management; 
specify Custom Options; and import Drill Text, Drills and Comprehension Tests. You can set the program up to be used 
the way you want your students to use the program. You can then monitor their use and track their progress. 

 

One of the most powerful features of AceReader Elite (Network Version) is the ability to administer activities in a reading 
lab environment.  

 

The Teacher/Administrator will log on with the name "Admin."  When logged on as Admin, you will have access to the 
Admin menu items. 

 

To learn more about the different areas of Administration see the appropriate section: 

 User Management  

 Custom Options Management  

 Drill Text Management  

 Drill Management  

 Comprehension Test Management  

 Game Text Management  

 Miscellaneous Options  
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User Management 

 

The Administrator can perform the following User Management activities, located under the Admin menu: 

 

Add Users: 

 

This function allows the teacher/Administrator to add Users. Users can be added manually or can be imported from 
a plain text file containing a list of Users. 

 

Manually adding Users:  

 

Type the User name and optionally their password (twice) then click the Add User button. Entering their 
password twice will help ensure that it was entered correctly. You can select an option that will allow the User 
to create their own password the first time they logon, or you can specify that you want to create it for them. If 
you are specifying their password and you leave it blank, then the User will not need to use a password to 
logon. 

 

Importing list of Users:  

 

To import a list of Users, click the Import User List button. This will prompt you for the file path of the 
import file and if the file is using semicolons or tabs for field delimiters. 

 

The format of the import file is as follows: 

 

This file is a plain text (*.txt) file. Each line of the file contains three fields separated by a tab or 
semicolon. 

 

FIELD 1: User name (up to 30 characters). 

 

FIELD 2: User password (up to 8 characters). If you don’t want User to have a password, then enter 
the text “none” (without the quotes). If you want the User to create his own password the first time he 
logs on, then enter “User” (without the quotes). 

 

FIELD 3: Class name (up to 100 characters). This field specifies an optional class (i.e. class name, 
teacher’s name or class description) to which this student is assigned. This will allow other operations 
(i.e. viewing Test Results, exporting Test Results…) to occur on a class basis. If you don’t want the 
User to be assigned to a class, then enter “none” (without the quotes). 

 

EXAMPLE IMPORT FILE ENTRIES: 

   Sam Smith; none; none 

   Sue Ingram; User; Mrs. Franks Class 

   Mike Ward; mw2309; none 

 

Assign Users to Classes: 

This function allows the Teacher/Administrator to assign Users to classes so that certain Administration functions 
can be performed on a class basis. Assigning Users to a class is recommended if more than one class and/or 
Teacher is using AceReader Elite in the same reading lab environment. 

Note: A student can only exist in one class.  

When you assign Users to classes, you can then perform the following actions on a class basis: 

 Remove all Users in a class. 

 View Test result graphs for all Users in a class. 

 Clear Test Results for all Users in a class. 

 Export Test Results for all Users in a class. 
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To Add a Class: 

 Click the Add Class button. 

 Enter the class name. 

 Click OK. 

 

To Remove a Class: 

 Highlight the class you want to remove in the Classes list. 

 Click the Remove Class button. 

 

To Assign a User to a Class: 

 Highlight the class in the Classes list. 

 Highlight the User name in the List of All Users list. 

 Click the Assign Selected User to Selected Class button. 

 Click OK to exit. 

Note: If the User that you want to assign to a class is not in the List of All Users list, then that means the 
User has not yet logged onto the system. Users are created when the User first logs on. 

 

To Remove a User from a Class: 

 Highlight the class in the Classes list. 

 Highlight the User name in the Users in Selected Class list. 

 Click the Remove User from Class button. 

 Click OK to exit. 

 

Remove User: 

This function allows you to remove Users. You can remove all Users, all Users in a specified class or a single User.  

Warning: Removing a User will permanently remove his or her Test Score history.  

 

Remove User Password: 

This function allows you to remove User passwords. 

 If a User forgets his or her password, the Administrator can perform this function to remove the User’s password. 
The User will be prompted to create a new password the next time he or she logs on. 

Note:  If the Admin User forgets his or her password, you must select: Programs -> AceReaderPro(Server) -> 
Remove Admin Password, from the Windows Start menu. This procedure must be done on the server (the 
machine where the program was installed). Once the Admin password is removed, the Admin User must recreate a 
new password the next time he or she logs to the system. 

 

User Logons (Network Version Only): 

This function allows you to view who is logged on and also allows you to log Users off. 

When to log Users off: It is valid to log a User off through this function if you are sure the User is not logged on. In 
other words, it is recommended that you log a User off using this function if you know that User is not running 
AceReader on any computers within the Network. This may be the case if a User was using AceReader and did 
not log off before the computer system was shut down or crashed. 

If the system or Network is shut down while a User is logged on, the User will still appear to be logged on to the 
AceReader server. When a User is logged on, a lock file is created for that User. When a User logs off, the lock file 
is removed for that User. The lock file is a flag that indicates that the User is logged on. If the system or Network is 
shut down or crashes while the User is logged on, then the lock file will still exist. Logging a User off removes the 
lock file for a User so that the User will not appear to be logged on. You should only log a User off if he or she is 
truly not logged on (i.e. if system was shut down while User was logged on). 

 

View User Comprehension Test Results: 
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This function allows you to view the Comprehension Test Results for specified Users. You can view the detailed 
Test Results for a single User or you can quickly browse through all the graphs for multiple Users. 

The graphs show both speed and comprehension results. The graphs are lined up so that you can see how the 
User’s Speed and Comprehension Scores correlate. 

Note: You can specify filters by clicking the Filter Options button. Filter options allow you to filter out certain Test 
Results. Examples of Test Results that you may want to filter out: (1) Test Results for Tests that have been 
repeated, (2) Test Results for Tests that have been previously canceled, (3) Test Results for Self-Paced Tests that 
indicate extremely low or extremely high reading speeds (i.e. User was distracted or walked away from program or 
quickly clicked the Done button while the story was being presented during a Self-Paced Reading Comprehension 
Tests)… The default setting is recommended and will help you monitor valid Test Results over time.  

 

Clear Individual or All User Comprehension Test Results: 

This function allows you to clear Comprehension Test Results. 

Note: This will permanently remove the Test Result history from the database. 

 

Export User Comprehension Test Results: 

This function allows you to export the Comprehension Test Results to a file on your disk. This is useful if you want 
to further process the Test Results data (i.e. using a spreadsheet program) or if you want to print the data.  

Note: You can specify filters by clicking the Filter Options button. Filter options allow you to filter out certain Test 
Results. Examples of Test Results that you may want to filter out: (1) Test Results for Tests that have been 
repeated, (2) Test Results for Tests that have been previously canceled, (3) Test Results for Self-Paced Tests that 
indicate extremely low or extremely high reading speeds (i.e. User was distracted or walked away from program or 
quickly clicked the Done button while the story was being presented during a Self-Paced Reading Comprehension 
Tests)… The default setting is recommended and will help you monitor valid Test Results over time.  

Note: You can specify if you want the data fields to be separated by tabs or by commas.  

Note: If you want to view or print this data it is recommended that you load this file into a spreadsheet program. 
When loading/importing the file into your spreadsheet program you will want to specify the field delimiter you used 
during the export operation. The field delimiters allow all your data to be lined up in columns of the spreadsheet. 
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Comprehension Test Management 

 

The Comprehension Test Management functions enable you to Add, Edit, and Remove Comprehension Tests. You 
can also Create, Duplicate, Remove, Import and Export Comprehension Test Sets. 

Note: Set names that begin with the special "#" character are Sets that came with the original installation and are 
Read-Only. You are not allowed to change these Sets, but you can duplicate them and then make changes to the 
duplicated Sets. 

The Administrator can perform the following Comprehension Test Management activities, located under the Admin 
menu: 

Comprehension Test Editor 

This function allows you to Create and Edit Comprehension Tests.  

The Comprehension Test Editor allows you to enter (by hand or by pasting from the clipboard) the story and Test 
questions for each Test. Each Test question has multiple choices for the answer. Use the Choice and Question 
buttons to select the current question and choice set for editing. You will also want to mark the correct answer with 
the blue arrow. 

The Comprehension Test Editor includes a Readability Statistics Tool and a Spell Checker. Click the Readability 
Statistics button if you want to see the Readability Statistics of the story text. The Readability Statistics will help 
you determine the grade level of the text. The Readability Statistics are not meant to be definitive, but they can be 
used to help you determine the grade level readability of each story. 

You will want to use the Paste Clipboard button if you want to transfer text from other applications (i.e. word 
processor, Web browser…) into the story field. You can also click your right mouse button while the cursor is 
positioned in any of the fields to paste information into that field.  

Note: If you have a file on your disk that contains text that you want to use in your Comprehension Test, you will 
need to bring up another word processor (i.e. Notepad, WordPad…), load the file, copy text into the clipboard, then 
use the Paste Clipboard button (or press your right mouse button while the cursor is positioned in any of the 
fields) to transfer the text into the Test field. 

Note: You can display graphics instead of text. To do this, the story field needs to define the graphic that you want 
to display. Refer to Administration “Graphic Files Support” section. Stories that define graphics can only be 
accessed from the Forced/Speed Mode Tests. 

 

Remove Comprehension Test 

This function allows you to remove individual Comprehension Tests from existing Comprehension Test Sets.  

 

Create New Comprehension Test Set 

This function allows you to create a new Comprehension Test Set. After the creation of a new Set, the Set is 
empty. You will need to invoke the Comprehension Test Editor to add entries to the new Set. 

 

Duplicate Comprehension Test Set 

This function allows you to duplicate an existing Comprehension Test Set. You may want to duplicate an existing 
Set if you want to create a similar new Set (i.e. you may want to duplicate and modify one of the Sets that came 
with the initial installation). To create a similar Set, you would first duplicate an existing Set and then modify the 
entries in the new Set with the Comprehension Test Editor.  

 

Remove Comprehension Test Set 

This function allows you to remove an existing Comprehension Test Set. 

 

Import Comprehension Test Set 

This function allows you to import an existing Comprehension Test Set. The import/export functions allow 
AceReader Elite Users to share custom content. 

 

Export Comprehension Test Set 

This function allows you to export an existing Comprehension Test Set. The import/export functions allow 
AceReader Elite Users to share custom content. 
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Game Text Management 

The Game Text Management functions enable you to Add, Edit, and Remove Game Text. You can also Import and 
Export Game Text. 

 

Note:  Game Text names that begin with the special "#" character came with the original installation and are Read-
Only. You are not allowed to change these Game Text entries, but you can load them into the Editor, modify them and 
then save them using a different name.  

 

The Administrator can perform the following Game Text Management activities, located under the Admin menu: 

 

Game Text Editor 

This function allows you to create and edit Game Text. You can enter the text by hand or by pasting from the 
clipboard. 

Each Game has its own Game Text Editor. All program Users can select the newly created Game Text by pressing 
the Options button from within each Game. 

Each Game text Editor has a different Set of formatting rules. Refer to the formatting rules at the top of the Editor 
(above the text input field). The rules must be followed in order to save the Game text.  

Click the Paste Clipboard button if you want to transfer text from other applications (i.e. word processor, Web 
browser …) into the Game Text field. You can also click your right mouse button while the cursor is positioned in 
the Game Text field to paste information into that field.  

Note: If you have a file on your disk that contains text you want to use as Game Text, you will need to bring up 
another word processor (i.e. Notepad, WordPad, etc.), load the file, copy text into the clipboard, then use the Paste 
Clipboard button (or press your right mouse button while the cursor is positioned in the Drill Text field) to transfer 
the text into the Game Text field. 

  

Remove Game Text 

This function allows you to remove Game Text.   

 

Import Game Text  

This function allows you to import existing Game Text. The import/export functions allow AceReader Elite Users to 
share custom content. 

 

Export Game Text  

This function allows you to export existing Game Text. The import/export functions allow AceReader Elite Users to 
share custom content. 
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Custom Options Management 

 

The Custom Options Management functions enable you to Add, Replace and Remove Custom Options. You can also 
Create, Duplicate, Remove, Import and Export Custom Option Sets. 

 

Note: Set names that begin with the special "#" character are Sets that came with the original installation and are 
Read-Only. You are not allowed to change these Sets, but you can duplicate them and then make changes to the 
duplicated versions. 

 

The Administrator can perform the following Custom Options Management activities, located under the Admin menu: 

 

Add Custom Option Setting: 

This function allows you to create and replace Custom Options.  

Before selecting this menu item, you will need to set all the options. You may find it useful first to select an existing, 
Preset option under the Preset-Options menu that is close to what you want. Then you can manually make 
changes to any of the options found under the Options menu. The speed and screen size are included as part of 
the option Settings. Once you have all the options the way you want, use the Add Custom Option Setting to add or 
replace an entry in an existing Custom Options Set. 

After you have created the custom options, any and all program Users can select them (via the Custom Option 
Settings menu item). The custom options can also be used when defining Drills (refer to: Drill Management). 

 

Remove Custom Option Setting: 

This function allows you to remove individual Custom Options entries from existing Custom Option Sets.  

 

Create New Custom Options Set 

This function allows you to create a new Custom Options Set. When you create a new Set, it remains empty until 
you add new entries. Refer to Add Custom Option Setting on how to add entries to the new Set. 

 

Duplicate Custom Options Set 

This function allows you to duplicate an existing Custom Options Set. You may want to duplicate an existing Set if 
you want to create a similar new Set (i.e. you may want to duplicate and modify one of the Sets that came with the 
initial installation). To create a similar Set, first duplicate an existing Set and then modify the entries in the new Set 
by adding, replacing and removing entries.  

 

Remove Custom Options Set 

This function allows you to remove an existing Custom Options Set.  

 

Import Custom Options Set 

This function allows you to import an existing Custom Options Set. The import/export functions allow AceReader 
Elite Users to share custom content. 

 

Export Custom Options Set 

This function allows you to export an existing Custom Options Set. The import/export functions allow AceReader 
Elite Users to share custom content. 
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Drill Text Management 

 

The Drill Text Management functions enable you to Add, Edit, and Remove Drill Text. You can also Create, Duplicate, 
Remove, Import and Export Drill Sets. 

 

Note:  Set names that begin with the special "#" character are Sets that came with the original installation and are 
Read-Only. You are not allowed to change these Sets, but you can duplicate them and then make changes to the 
duplicated versions. 

 

The Administrator can perform the following Drill Text Management activities, located under the Admin menu: 

 

Drill Text Editor 

This function allows you to create and edit Drill Text. You can enter the text by hand or by pasting from the 
clipboard. 

The main purpose of creating Drill Text is to use it in the Drills (refer to: Drill Management). All program Users can 
select this material (via the Load Drill Text menu item).  

The Drill Editor includes a Readability Statistics Tool and a Spell Checker. Click the Readability Statistics button 
to determine the grade level of the text. The readability statistics are not meant to be definitive, but they can be 
used to give you a general idea of each Drill Text entry’s difficulty. 

Click the Paste Clipboard button if you want to transfer text from other applications (i.e. word processor, Web 
browser …) into the Drill Text field. You can also click your right mouse button while the cursor is positioned in the 
Drill Text field to paste information into that field.  

Note: If you have a file on your disk that contains text you want to use as Drill Text, you will need to bring up 
another word processor (i.e. Notepad, WordPad, etc.), load the file, copy text into the clipboard, then use the Paste 
Clipboard button (or press your right mouse button while the cursor is positioned in the Drill text field) to transfer 
the text into the Drill Text field. 

Note: You can display graphics instead of text. To do this, the Drill text defines the graphic that you want to 
display. Refer to Administration “Graphic Files Support” section.  

  

Remove Drill Text 

This function allows you to remove individual Drill Text entries from existing Drill Text Sets.  

 

Create New Drill Text Set 

This function allows you to create a new Drill Text Set. When you create a new Set, it remains empty until you add 
new entries. You will need to use the Drill Text Editor to add entries to the new Set.  

 

Duplicate Drill Text Set 

This function allows you to duplicate an existing Drill Text Set. You may want to duplicate an existing Set if you 
want to create a similar new Set (i.e. you may want to duplicate and modify one of the Sets that came with the 
initial installation). To create a similar Set, you would first duplicate an existing Set and then modify the entries in 
the new Set with the Drill Text Editor.  

 

Remove Drill Text Set 

This function allows you to remove an existing Drill Text Set. 

 

Import Drill Text Set 

This function allows you to import an existing Drill Text Set. The import/export functions allow AceReader Elite 
Users to share custom content. 

 

Export Drill Text Set 

This function allows you to export an existing Drill Text Set. The import/export functions allow AceReader Elite 
Users to share custom content. 

 

 



Using AceReader Elite 

97 

Drill Management 

 

The Drill Management functions enable you to Add, Edit and Remove Drills. You can also Create, Duplicate, Remove, 
Import and Export Drill Sets. 

 

Note:  Set names that begin with the special "#" character are Sets that came with the original installation and are 
Read-Only. You are not allowed to change these Sets, but you can duplicate them and then make changes to the 
duplicated versions. 

 

The Administrator can perform the following Drill Management activities, located under the Admin menu: 

 

Drill Editor 

This function allows you to Create, Edit, and Remove Drills.  

Drills define how text will be presented (flashed) to the User. Drills pace the User’s reading and can be used as 
exercises to increase eye span. Drills can be grouped together into Sets of related content and each Drill is made 
up of sessions that define: (1) the Reading Material; (2) the Option Settings; and (3) the Speed. The Speed Setting 
can be explicit or relative to the User’s Base Reading Speed. 

Since Drill definitions require that you specify both Drill Text and Custom Option Settings, make sure you have 
established those items before attempting to create Drills using the Drill Editor. Refer to Drill Text Management and 
Custom Options Management for more information. 

Note: Drills do not have associated Test questions. Test questions are associated only with the Comprehension 
Tests. If you want to force the speed and mode of text presentation and have associated Test questions as well, 
then refer to the sections titled: Take Comprehension Test (Forced Speed/Mode) and Comprehension Test 
Management for instructions. 

Note: A benefit of using the User’s Base Reading Speed (vs. an explicit speed) is that the Drills will automatically 
become more challenging as the User’s skills improve. 

Create New Drill Set 

This function allows you to create a new Drill Set. When you create a new Set, it remains empty until you add new 
entries. You will need to use the Drill Editor to add entries to the new Set.  

Duplicate Drill Set 

This function allows you to duplicate an existing Drill Set. You may want to duplicate an existing Set if you want to 
create a similar new Set (i.e. you may want to duplicate and modify one of the Sets that came with the initial 
installation). To create a similar Set, you would first duplicate an existing Set and then modify the entries in the new 
Set with the Drill Editor.  

Remove Drill Set 

This function allows you to remove an existing Drill Set. 

 

Import Drill Set 

This function allows you to import an existing Drill Set. The import/export functions allow AceReader Elite Users to 
share custom content. 

 

Export Drill Set 

This function allows you to export an existing Drill Set. The import/export functions allow AceReader Elite Users to 
share custom content. 
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Set Base Reading Speed Options 

The Base Reading Speed (BRS) for a student is determined from their most recent "qualified" Self-Paced Reading 
Comprehension Test result. Their Base Reading Speed is the speed in which they read the story while taking the Test. 
Test Results are "qualified" using filter criteria specified on this screen. 

 

 

Set Personal Goal 

Allows you to set your personal goal.  Personal goals allow you to monitor your progress relative to your Goal.  Goals 
are also used by Drills to determine pacing speeds. 
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Miscellaneous Options 

 

Lockout ability to load Comprehension Test Stories from File menu 

When this option is set, students are not allowed to load Test stories from the File menu (within the Reading Mode 
screen). When this option is set, students will not have an opportunity to get familiar with Test stories before taking 
Reading Comprehension Tests. Typically, you will want to keep this option set unless you want access to the reading 
Comprehension Test stories from the Reading Mode screen and you are not concerned about reading Comprehension 
Test Results. 

 

Force “Home Screen” (tabs) to always appear when Users log on 

When this option is set, students will be forced to see the “Home Screen” (screen with tabs) when they log on.  

Note: This will lock the checkbox option on the Reading Mode tab screen to an unchecked state. 

 

Allow ability to manually override Drill Session Speeds 

When students are performing the Drills, they will be presented with recommended speeds for each Drill session. If 
this option is checked, then students can manually override the recommended Drill session speeds before each Drill 
session. 

 

Force Users to type their logon name when logging on 

If this option is unchecked, then Users will be presented with a drop down list to pick from for their User names. This is 
often a good idea so that Tommy does not log on as Tom one day and Tommy another day. 

 

Allow new Users to be created from logon screen 

When this option is set, new Users can be added from the logon screen. If this option is not set, then new Users can 
only be added via the Add Users function (found under the Admin User Management menu). 

 

Lockout Menu Mode access (for all Users except Admin) 

When this option is set, only the Admin User can access the Menu Mode Tab on the “Home Screen” (main home 
screen with tabs).  

 

Lockout Reading Mode access (for all Users except Admin) 

When this option is set, only the Admin User can access the Reading Mode Tab on the “Home Screen” (main home 
screen with tabs).  

 

Force Course Activities to be performed in order 

You may want to check this option if you want students to perform all the Course Mode activities in the recommended 
order. If you want to perform activities in a different order, you may consider using the Menu Mode. 

 

Force completion of Course Activities before marking as performed 

You may want to keep this option unchecked if you want students to be cancel out of an activity and move on down 
the Course Mode list. 

 

Number of Course Mode activities to perform each day (5 is recommended, excluding Intro activities) 

We recommend 5 activities a day in the Course Mode (excluding the Intro activities). The Daily Completion Status 
thermometer will update according to this option setting. 

 

Hide "Back to Story" button on quizzes 

To simulate real world test taking that allows students to go back and forth between the story and the quiz, you may 
want to keep this unchecked. 

 

Change Font 

This is the font used when presenting stories during Self-Paced Reading Comprehension Tests and also when 
presenting course tips. 
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Graphic Files Support (PC Version) 

It is possible to load graphic files. You can load graphic files (i.e. .jpg, .png and .bmp files) indirectly through the use of 
Graphics Definition Files.  Graphics Definition Files are plain text files that define what images to display along with 
other display properties. You can load Graphics Definition Files from the Reading Mode. Drill Text and 
Comprehension Test stories can also utilize the Graphics Definition File format if you want to display graphics during 
Tests and Drills.  

 

Note: For test-taking purposes, if you create Comprehension Tests that use graphics, you will only be able to access 
those Tests from the Forced Speed/Mode Tests (i.e. from the Menu Mode). 

 

Below is a sample graphics definition file along with the comments. It is recommended that if you want to create a 
graphics definition file, you should copy and paste the example below. NOTE: You must keep the first two lines “as is,” 
and we recommend that you leave all the comments in place for documentation purposes. 

 

//---------------------------------------------------- 

// ACEREADER IMAGE FILE  

// 

// IMPORTANT NOTE: Must Keep 1st two lines of this  

//                 file "as is". 

// 

// NOTE: IT IS A GOOD IDEA TO KEEP EXISTING COMMENTS 

//       IN PLACE FOR DOCUMENTATION PURPOSES. 

// 

// NOTE: For 1024x768 display, you can assume the the 

//       display area to be 958x540 pixels. 

//       Images are only shown if they fit on display. 

 

// NOTE: For 800x600 display which is the smallest  

//       assumed display size, you can assume the the 

//       display area to be 734x372 pixels. 

//       Images are only shown if they fit on display. 

//---------------------------------------------------- 

 

//---------------------------------------------------- 

// NEXT LINE DEFINES BACKGROUND RGB VALUE  

// (numbers between 0 and 255) 

// 255 = White 

// 0   = Black 

//---------------------------------------------------- 

255,255,255 

 

//---------------------------------------------------- 

// EACH HAS THE FOLLOWING FIELDS: 

// (1) Image path. 

// (2) XY Mode. 

//     0 = Absolute xy coord.  

//     1 = Screen partions (x=1-10, y=1-10). 

// (3) X position. 

// (4) Y position. 

// (5) Time in milliseconds to flash image. 

// (6) Time in milliseconds to flash orig background. 
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//     Note: Can Set to 1 if you don't want delay 

//           but want to erase last image. 

//---------------------------------------------------- 

 

 

//---------------------------------------------------- 

// EXPANDING BALLS                                     

//---------------------------------------------------- 

c:\images\1.jpg,     1,5,5,600,0              

c:\images\2.jpg,     1,5,5,600,0              

c:\images\3.jpg,     1,5,5,600,0              

c:\images\4.jpg,     1,5,5,600,0              

c:\images\5.jpg,     1,5,5,600,0              

c:\images\6.jpg,     1,5,5,600,0              

c:\images\7.jpg,     1,5,5,600,0              

c:\images\8.jpg,     1,5,5,600,0              

c:\images\9.jpg,     1,5,5,600,0              

c:\images\10.jpg,    1,5,5,600,0              

c:\images\11.jpg,    1,5,5,600,0              

c:\images\12.jpg,    1,5,5,600,0              

c:\images\13.jpg,    1,5,5,600,0              

c:\images\14.jpg,    1,5,5,600,0              

c:\images\15.jpg,    1,5,5,600,0              

c:\images\16.jpg,    1,5,5,600,0              

c:\images\17.jpg,    1,5,5,600,0              

c:\images\18.jpg,    1,5,5,600,0              

c:\images\19.jpg,    1,5,5,600,0              

c:\images\20.jpg,    1,5,5,600,1              

 

c:\images\1.jpg,     1,5,5,400,0              

c:\images\2.jpg,     1,5,5,400,0              

c:\images\3.jpg,     1,5,5,400,0              

c:\images\4.jpg,     1,5,5,400,0              

c:\images\5.jpg,     1,5,5,400,0              

c:\images\6.jpg,     1,5,5,400,0              

c:\images\7.jpg,     1,5,5,400,0              

c:\images\8.jpg,     1,5,5,400,0              

c:\images\9.jpg,     1,5,5,400,0              

c:\images\10.jpg,    1,5,5,400,0              

c:\images\11.jpg,    1,5,5,400,0              

c:\images\12.jpg,    1,5,5,400,0              

c:\images\13.jpg,    1,5,5,400,0              

c:\images\14.jpg,    1,5,5,400,0              

c:\images\15.jpg,    1,5,5,400,0              

c:\images\16.jpg,    1,5,5,400,0              

c:\images\17.jpg,    1,5,5,400,0              

c:\images\18.jpg,    1,5,5,400,0              

c:\images\19.jpg,    1,5,5,400,0              

c:\images\20.jpg,    1,5,5,400,1
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Reference 

For System Requirements and Installation Instructions, please refer to the Quick Start Guide. Quick Start Guides are 
found at the www.acereader.com Web site in the support section. 

 

Technical Support 

 

If the online help and AceReader Web site have not addressed your issue, contact StepWare, Inc. in the following 
ways: 

E-Mail 

support@stepware.com 

US Mail 

StepWare, Inc. 

619 Main Street 

Grand Junction, CO 81502 

Telephone 

1-800-ACE-READ (1-800-223-7323), Ext. 2 
International: 970-243-9390, Ext. 2 

Fax 

970-243-9482 
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 License Agreement 

For ordering information, see the section titled: Order Information. 

 

STEPWARE IS WILLING TO LICENSE THE PROGRAM ONLY UPON THE CONDITION THAT YOU ACCEPT ALL 
OF THE TERMS CONTAINED IN THIS LICENSE AGREEMENT. PLEASE READ THE TERMS CAREFULLY 
BEFORE CLICKING ON "YES" AND INSTALLING THE PROGRAM, AS CLICKING ON "YES" AND INSTALLING THE 
PROGRAM WILL INDICATE YOUR AGREEMENT WITH THEM. IF YOU DO NOT AGREE WITH THESE TERMS, 
THEN STEPWARE IS UNWILLING TO LICENSE THE PROGRAM TO YOU, IN WHICH EVENT YOU SHOULD NOT 
CLICK "YES" AND YOU SHOULD NOT PURCHASE OR USE THE PROGRAM.  

STEPWARE'S LICENSE AGREEMENT FOR REGISTERED/UNREGISTERED-DEMO VERSIONS WHICH 
INCLUDES LIMITED WARRANTY AND DISCLAIMER: 

 

(1) Introduction. This agreement explains when and how you may use both UNREGISTERED-DEMO and 
REGISTERED copies of software products from StepWare Inc. 

 

In this agreement: 

 

"Program" means the StepWare Inc. software products(s) you have purchased or obtained for evaluation, including 
both the software and the associated documentation and other materials; 

 

"UNREGISTERED-DEMO Copy" means a copy of the Program distributed by us or by our authorized agents for 
evaluation purposes and which is described as an UNREGISTERED-DEMO copy in the Program's sign-on messages; 

 

"REGISTERED Copy" means a copy of the Program purchased from us or from a dealer, and which is not described 
as an UNREGISTERED-DEMO copy in the Program's sign-on messages; 

 

"We" or "us" means StepWare Inc., a corporation based in Grand Junction, Colorado, USA; and 

 

"You" means the end User of the Program. 

 

(2) Legal Agreement. This is a legal agreement that allows you, the end User, to use the Program under certain terms 
and conditions provided herein.  

 

(3) Copyright. The Program is fully protected by copyright owned by StepWare, Inc. under U.S. law and international 
treaty provisions. You agree that you shall not reverse engineer, decompile, or disassemble the Program for any 
purpose. 

 

(4) Patents. This program contains elements that are patented and owned by StepWare, Inc. 

 

(5) Trademarks. StepWare® and AceReader® are registered trademarks of StepWare, Inc. 

 

(6) Evaluation Period. You may use an UNREGISTERED-DEMO Copy of the Program for an evaluation period of up to 
30 days, in order to determine whether the program meets your needs before purchasing it. Once the evaluation period 
ends, you agree to either purchase a REGISTERED Copy of the Program, or to stop using it. If you have ordered a 
REGISTERED Copy of the Program from us or from a dealer, you may continue to use your UNREGISTERED-DEMO 
Copy until your REGISTERED Copy arrives. 

 

(7) Use of the Program. While you are evaluating the Program, you may use it on as many computers as are required 
to perform your evaluation. Your 30-day evaluation period begins when you first install the Program on one or more 
computers for evaluation purposes. Once the evaluation period is over and you purchase the program, your use is 
subject to the following restrictions: 

 

Personal Editions of AceReader: 
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Each license allows for 3 activations and up to 3 computer installations. Multiple activations are provided to allow up to 
3 installations onto PCs within the household (or personal work computer), or in the event that you need to re-install 
the software.  

 

Single Station School and Business Editions of AceReader: 

You can purchase a license for the number of computers that you want to run the software at the registered site. 

 

Network Editions of AceReader: 

License is for concurrent Users. The number of seats figure specifies how many students can use the program at the 
same time. Client-side software can be installed on unlimited computers at the registered site. 

 

 

If the Program was purchased by your employer, you agree to get your employer's explicit permission before installing 
the Program on multiple computers as described above.  

 

(8) Making and Distributing UNREGISTERED-DEMO Copies of the Program. You may make copies of your 
UNREGISTERED-DEMO Copy of the Program to give to others, as long as you include all of the files that you 
originally received with your UNREGISTERED-DEMO Copy. When you give an UNREGISTERED-DEMO Copy of the 
Program to another person, you agree to inform them that their copy is to be used for a time limited evaluation period, 
and that they must purchase a REGISTERED Copy if they continue to use the Program once the evaluation period has 
ended. You agree not to sell UNREGISTERED-DEMO Copies of the Program or distribute them to others for any kind 
of compensation or fee unless you have written permission from StepWare Inc. 

 

(9) Copying REGISTERED Copies of the Program. When you receive a REGISTERED Copy of the Program you may 
make copies of the Program software which are necessary for normal backup purposes. You agree not to make any 
other copies of the software, the manual(s), or any part of them, or sell or give any copies to others, without our 
advance written permission. 

 

(10) Operation of the Program. You assume full responsibility for the selection and use of the Program to achieve your 
intended results. 

 

(11) LIMITED WARRANTY. The following limited warranty applies to REGISTERED Copies of the Program. It is 
included here so you understand what your warranty will be when you purchase a REGISTERED Copy. This warranty 
does NOT apply to UNREGISTERED-DEMO Copies of the Program. 

 

Physical Defects. We pledge that the disks and manuals we send you will arrive free of physical defects that interfere 
with normal use. If you find such a defect and report it to us within 90 days after you purchase the Program, we agree 
to replace the defective item(s) at no charge to you as long as the defect was not caused by misuse or abuse. 

 

Bugs and Program Errors. We don't promise that the Program will be free of bugs or program errors. If, within one year 
after you purchase the Program, you report a program error or bug to us, we will use our best efforts to correct it. If we 
issue a maintenance release for the Program which includes a correction for an error you reported, we will send you a 
copy of that maintenance release at no charge if you request it. We will only do this for maintenance releases, not for 
new major releases or other new versions of the Program. THE REMEDIES PROVIDED ABOVE ARE YOUR SOLE 
AND EXCLUSIVE REMEDY, AND STEPWARE'S SOLE AND EXCLUSIVE OBLIGATION AND LIABILITY, FOR 
BREACH OF THE WARRANTIES REGARDING PHYSICAL DEFECTS AND BUGS AND PROGRAM ERRORS. 

 

(12) DISCLAIMERS AND LIMITATIONS. 

 

DISCLAIMER FOR UNREGISTERED-DEMO COPIES:  YOU ARE NOT PAYING FOR THE TRIAL USE LICENSE 
FOR YOUR UNREGISTERED-DEMO COPY OF THE PROGRAM. ACCORDINGLY THE UNREGISTERED-DEMO 
COPY IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND. 

 

DISCLAIMER FOR REGISTERED COPIES:  EXCEPT FOR THE LIMITED WARRANTY STATED ABOVE, WE 
DISCLAIM ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, ORAL OR WRITTEN, INCLUDING ANY 
IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. THE 
LIMITED WARRANTY ABOVE GIVES YOU SPECIFIC LEGAL RIGHTS, BUT YOU MAY HAVE OTHER RIGHTS, 
WHICH VARY FROM STATE TO STATE. 
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LIMITATION OF LIABILITY:  IN NO EVENT SHALL WE BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, OR 
PUNITIVE DAMAGES WHATSOEVER ARISING OUT OF USE OF THE PROGRAM OR YOUR RELATIONSHIP 
WITH US. SOME STATES DO NOT ALLOW EXCLUSION OR LIMITATION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, THEREFORE THE ABOVE LIMITATION MAY NOT APPLY TO YOU. IN NO EVENTS 
SHALL STEPWARE'S TOTAL, CUMULATIVE LIABILITY UNDER ANY AND ALL THEORIES OF LIABILITY AND 
CAUSES OF ACTION EXCEED THE PURCHASE PRICE PAID FOR THE PROGRAM LICENSE.  

 

EXPORT CONTROLS. You agree to comply with all export laws and restrictions and regulations of the United States 
or foreign agencies or authorities, and not to export or re-export the Programs or any direct product thereof in violation 
of any such restrictions, laws or regulations, or without all necessary approvals.  

 

MISCELLANEOUS. This Agreement constitutes the entire understanding of the parties with respect to the subject 
matter of this Agreement and merges all prior communications, representations, and agreements. This Agreement may 
be modified only by a written agreement signed by the parties. If any provision of this Agreement is held to be 
unenforceable for any reason, such provision shall be reformed only to the extent necessary to make it enforceable. 
This Agreement shall be construed under the laws of Colorado, USA, excluding rules regarding conflicts of law. This 
license is written in English and English is its controlling language. 

 

U.S. GOVERNMENT END USERS. The Software and documentation are provided with RESTRICTED RIGHTS. Use, 
duplication, or disclosure by the United States Government is subject to restrictions as Set forth in subparagraph (c)(1) 
and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. StepWare, Inc. is 
the manufacturer. 
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Purchasing AceReader Elite 

Order Information 

 

HOW TO ORDER 

 

It is possible to order by mail, credit card, phone and fax. Purchase Orders are welcome by schools, businesses and 
other institutions. For pricing, order forms, product id’s and other order details, please refer to: 
http://www.acereader.com/order.html .  

 

Other ways to contact us: 

 

WEB: http://www.acereader.com  

 

E-MAIL: sales@stepware.com   

 

PHONE (Information and Credit Card Orders): 

 

For Pre-Sales and Product Information: 

U.S. (toll-free): 1-800-ACE-READ (1-800-223-7323), ext. 2 

International: 1-970-243-9390, ext. 2 

 

For Credit Card Orders: 

U.S. (toll-free): 1-800-ACE-READ (1-800-223-7323), ext. 1 

International: 1-970-243-9390, ext. 1 

 

FAX: 970-243-9482 

 

POSTAL ADDRESS: 

StepWare, Inc. 

c/o AceReader 

619 Main Street 

Grand Junction, CO  81502 

USA 

 

WHAT YOU GET WHEN YOU ORDER 

When you order AceReader Elite you will receive the latest fully functional version of the program. The difference 
between the DEMO and FULLY FUNCTIONAL version of AceReader Elite are: 

 The FULLY FUNCTIONAL version does not have the 30-day usage limit. 
 The FULLY FUNCTIONAL version comes with an additional 761 reading/ Comprehension Tests that are broken 

out by grade levels 1-12 plus an additional adult level, giving you a total of 830 reading/ Comprehension Tests.  
 The FULLY FUNCTIONAL version does not have a limit on the number of activities that can be performed in the 

Course Mode. 
 The FULLY FUNCTIONAL version does not have the higher speed limitation. 
 The FULLY FUNCTIONAL version does not have the initial Try/Buy/Activate screen that pops up when 

AceReader Elite is started. 
 


